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Preface

StorNext provides high performance data sharing and intelligent
archiving that is compatible with an industry-leading range of operating
systems, server platforms, and storage devices.

StorNext includes two main components:

* StorNext File System (SNFS) is high performance data sharing
software that lets applications on multiple operating systems access a
single data set.

* StorNext Storage Manger (SNSM) is an intelligent, policy-based data
mover that automatically moves and locates data across multiple
storage tiers.

You can choose to install both StorNext File System and Storage Manager,
or install StorNext File System only. In addition, StorNext includes client
software that allows client systems to mount and work with StorNext file
systems.

StorNext 3.1.3 Installation Guide Xii
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Preface
Audience

Audience

This document is intended for service professionals and system

administrators who install StorNext software. The installer should have
strong familiarity with the operating system on which StorNext is
installed.

Only service professionals, experienced StorNext users, or individuals
who have successfully completed StorNext training should configure
StorNext. Attempting to configure StorNext without proper experience or
training can affect system performance and may result in data loss.

Purpose

This document provides information about installing and configuring
StorNext. The following topics are covered:

StorNext 3.1.3 Installation Guide

Download from Www.Somanuals.com. All Manuals Search And Download.

System requirements
Pre-installation tasks
Installation
Configuration

Uninstalling StorNext

Xiii
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Document Organization

Document Organization

This document contains the following chapters:

* Chapter 1, “Installing StorNext File System and Storage Manager,”
provides system requirements, pre-installation information, and
instructions for installing StorNext File System and Storage Manger
on a metadata controller (MDC).

* Chapter 2, “Installing StorNext File System,” provides system
requirements, pre-installation information, and instructions for
installing StorNext File System (without Storage Manager) on a
metadata controller (MDC).

* Chapter 3, “Installing the StorNext Client,” provides system
requirements, pre-installation information, and instructions for
installing the StorNext client software.

* Chapter 4, “Configuring StorNext,” describes how to use the
StorNext configuration wizard and the Windows configuration
utilities to create a basic StorNext configuration, and how to
configure a distributed LAN client or server.

* Appendix A, “Uninstalling StorNext,” describes how to remove
StorNext software from a server or client system.

StorNext 3.1.3 Installation Guide Xiv
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Notational Conventions

Preface
Notational Conventions

This manual uses the following conventions:

Convention

Example

User input is shown in Arial regular
font.

Jinstall.stornext

User input variables are enclosed in
angle brackets and are shown in
Arial italic font.

mkdir -p <mount point>

For UNIX and Linux commands, the
command prompt is implied.

Jinstall.stornext
is the same as
# ./install.stornext

File and directory names, menu
commands, button names, and
window names are shown in Arial
bold font.

/stornext/snfsl

Menu names separated by arrows
indicate a sequence of menus to be
navigated.

Admin > Download Client
Software

The following formats indicate important information:

topic.

Note: Notes emphasize important information related to the main

Tech Tip: Tech Tips provide technical information which may be
helpful in performing the procedure.

Caution:  Cautions indicate potential hazards to equipment and are
included to prevent damage to equipment.

XV
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Preface
Related Documents

Warning:

Warnings indicate potential hazards to personal safety and

are included to prevent injury.

Related Documents

Documents related to StorNext are shown below:

Quantum StorNext Documentation

Document No.

Document Title

Document Description

6-01658-06 StorNext User’s Guide | Provides in-depth
information about using
StorNext to create and
manage StorNext File
Systems.
6-01376-10 StorNext File System Provides information for
Tuning Guide maximizing file system
performance.
6-01620-09 StorNext Upgrade Provides procedures for
Guide upgrading from earlier
versions of StorNext.
6-01688-06 StorNext CLI Reference | Provides procedures for
Guide performing common tasks

using the command line
interface.

StorNext 3.1.3 Installation Guide
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Preface
Contacting Quantum

Document No.

Document Title

Document Description

6-01564-02

AMASS Conversion
Guide

Provides information about
migrating systems running
AMASS to StorNext.

6-00431-23

StorNext 3.1.3 Release
Notes

Includes the latest product
information, fixes, and
issues.

Contacting Quantum

More information about this product is available on the Quantum Service
and Support website at www.quantum.com/ServiceandSupport. The
Quantum Service and Support website contains a collection of
information, including answers to frequently asked questions (FAQs).
You can also access software, firmware, and drivers through this site.

To request a software upgrade, visit www.quantum.com/
ServiceandSupport/Upgrade/Index.aspx. For further assistance, or if

training is desired, contact Quantum Global Services:

North America

+1 800-284-5101 Option 5

EMEA

00800 9999 3822

Online Service and

Support

www.quantum.com/OSR

World Wide Web

www.quantum.com/ServiceandSupport

(Local numbers for specific countries are listed on the Quantum Service
and Support Website.)

StorNext 3.1.3 Installation Guide

XVii

Download from Www.Somanuals.com. All Manuals Search And Download.


http://www.quantum.com/ServiceandSupport
http://www.quantum.com/ServiceandSupport/Upgrade/Index.aspx
http://www.quantum.com/ServiceandSupport/Upgrade/Index.aspx
www.quantum.com/OSR
http://www.quantum.com/ServiceandSupport

H
| Chapter 1

Installing StorNext File System
and Storage Manager
D

D
Q

This chapter describes how to install StorNext File System (SNFS) and
StorNext Storage Manager (SNSM) on a metadata controller (MDC).
Install both SNFS and SNSM for storage systems that require policy-
based data movement (for example, systems that include tape drives or
libraries).

To ensure successful operation, do the following tasks before installing
StorNext:

* Make sure the MDC meets all operating system and hardware
requirements (see Storage Manager System Requirements).

* Make sure all storage devices are correctly configured and are visible
to the MDC (see Getting Ready to Install on page 5)

* (Optional) Run the pre-installation script to check for available disk
space and view recommended locations for support directories (see
Pre-Installation Script on page 8).

When you are ready to install StorNext File System and Storage Manager
on the MDC, run the installation script (see StorNext Installation Script
on page 12).

Note: To install only StorNext File System (without Storage
Manager), see Chapter 2, “Installing StorNext File System.” To
install the StorNext client software, see Chapter 3, “Installing
the StorNext Client.”

StorNext 3.1.3 Installation Guide 1
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Chapter 1 Installing StorNext File System and Storage Manager
Storage Manager System Requirements

Storage Manager System Requirements

To run StorNext File System and Storage Manager, the metadata
controller must meet all operating system, hardware, and LAN

requirements.
Operating System The operating systems, kernel versions, and hardware platforms
Requirements supported by StorNext SNFS and SNSM are presented in Table 1. Make

sure the MDC uses a supported operating system and platform, and if
necessary update to a supported kernel version before installing

StorNext.
Table 1 Storage Manager .
Supported Platf%rms g Operating System Kernel Platform
Red Hat Enterprise 2.6.9-55.EL (Update 5) x86 32-bit
Linux 4 x86 64-bit
2.6.9-67.EL (Update 6) Itanium 64-bit
2.6.9-78.EL (Update 7)
Red Hat Enterprise 2.6.18-53.EL (Update 1) x86 64-bit
Linux5 2.6.18-92.EL (Update 2)
SUSE Linux Enterprise | 2.6.16.21-0.8 x86 32-bit
Server 10 x86 64-bit
2.6.16-46-0.12 (SP1) Itanium 64-bit
2.6.16-60-0.27 (SP2)
Sun Solaris 10 Generic 120011-14 SPARC 64-bit

The minimum amount of RAM and available hard disk space required to
run StorNext SNFS and SNSM are presented in Table 2. Because support
files (such as database and journal files) are stored on the MDC, the
amount of local disk space that is required increases with the number of
data files stored on StorNext file systems.

Hardware Requirements

If necessary, upgrade the RAM and local disk storage in the MDC to meet
the minimum requirements before installing StorNext.

StorNext 3.1.3 Installation Guide 2
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Chapter 1 Installing StorNext File System and Storage Manager

Storage Manager System Requirements

Note: The RAM requirements in Table 2 are for running StorNext
File System and Storage Manager only. Running additional
software (including the StorNext client software) requires
additional RAM.

Table 2 Storage Manager

Hardware Requirements File Systems RAM Disk Space
1-4* 2GB * For application binaries, log files,
and documentation: up to 30GB
5-8** 4GB

(depending on system activity)

* For support directories: 3 GB per
million files stored

¢ For metadata: 25GB minimum

* Two CPUs recommended for best performance.
** Two CPUs required for best performance.

Note: If a file system uses deduplicated storage disks (DDisks), note

the following additional requirements:

* Requires 2 GB RAM per DDisk in addition to the base RAM
noted in Table 2.

* Requires an additional 5GB of disk space for application
binaries and log files.

* Deduplication is supported only for file systems running on
a Linux operating system (x86 32-bit or x86 64-bit).

* An Intel Pentium 4 or later processor (or an equivalent
AMD processor) is required. For best performance,
Quantum recommends an extra CPU per blockpool.

StorNext 3.1.3 Installation Guide
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Chapter 1 Installing StorNext File System and Storage Manager
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Partitioning Local Hard Disks

StorNext can be installed on any local file system (including the root file
system) on the MDC. However, for optimal performance, as well as to aid
disaster recovery, follow these recommendations:

Avoid installing StorNext on the root file system.

Partition local hard disks so that the MDC has four available local file
systems (other than the root file system) located on four separate
hard drives.

Note: You can run the pre-installation script to help determine the

estimated size of and optimal location for StorNext support
directories. For more information, see Pre-Installation Script
on page 8.

LAN Requirements

The following LAN requirements must be met before installing StorNext
on the MDC:

In cases where gigabit networking hardware is used and maximum
StorNext performance is required, a separate, dedicated switched
Ethernet LAN is recommended for the StorNext metadata network. If
maximum StorNext performance is not required, shared gigabit
networking is acceptable.

A separate, dedicated switched Ethernet LAN is mandatory for the
metadata network if 100 Mbit/s or slower networking hardware is
used.

The MDC and all clients must have static IP addresses.

Verify network connectivity with pings, and also verify entries in the
letc/hosts file.

If using Gigabit Ethernet, disable jumbo frames and TOE (TCP
offload engine).

Note: StorNext does not support file system metadata on the same

network as iSCSI, NFS, CIFS, or VLAN data when 100 Mbit/s
or slower networking hardware is used.

StorNext 3.1.3 Installation Guide
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Getting Ready to Install

Before installing StorNext SNFS and SNSM, complete the following tasks
to ensure successful installation:

* Correctly configure all storage devices (see Configuring Storage
Devices).

* If using LUNs larger than 1 TB, decide on a label type and install any
necessary operating system patches (see Planning for LUNs Larger
than 1 TB).

* (Linux only) Install the kernel source code (see Installing the Linux
Kernel Source Code on page 7).

Configuring Storage Before installing StorNext SNFS and SNSM, make sure that all LUNSs are
Devices visible to the MDC. (A LUN, or logical unit number, is a logical device
that corresponds to one or more disks, drives, or storage devices.)

If there are any connection issues, resolve them before installing
StorNext. For assistance in configuring storage devices, refer to the
documentation that came with the storage device, or contact the
manufacturer.

Note: LUNSs that you plan to use in the same stripe group must be
the same size. Consider this when configuring storage devices.
(For more information about stripe groups, see the StorNext
3.1.3 User’s Guide.)

Caution:  StorNext does not support the connection of multiple
devices through fibre channel hubs. Multiple devices must
be connected using fibre channel switches.

Planning for LUNs Larger StorNext supports LUNs greater than 1 TB in size if they are allowed by
than 1 TB the operating system. To enable support for 1 TB or larger LUNS, all
StorNext LUNs must be correctly labeled according to the requirements

StorNext 3.1.3 Installation Guide 5
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Getting Ready to Install

of the operating system running on the MDC as well as the operating
system running on all connected clients. Disk LUNs can have one of three
labels: VTOC, EFI, or sVTOC (short VTOC).

Required disk LUN label settings based on operating system and LUN
size are presented in Table 3. Before installing StorNext, decide what

label type will be used, and then install any required operating system
patches or updates (for both MDC and client) as indicated in the notes for

Table 3.
Note: After labeling a disk LUN, you must reboot systems running
Solaris before they can access the disk LUN.

Izzfl: Required Disk LUN Operating Label for Label for Label for
System LUNs <1TB LUNs 1-2 TB LUNs >2TB
Windows XP? | VTOC, EFI VTOC, EFI EFI, sVTOC
Windows 2003 | VTOC, EFI VTOC, EFI EFI, sVTOC
Server
Linux 2.6 VTOC, EFI VTOC, EFI EFI, sVTOC
Kernel
Linux 2.4 VTOC, EFI VTOC, EFI Not supported
Kernel
Solaris 9° VTOC, EFI EFI Not supported
Solaris 10° VTOC, EFI EFI EFI
HP-UX? VTOC, EFI VTOC, EFI EFI, sVTOC
IBM AIX4 VTOC, EFI VTOC, EFI EFI, sVTOC
SGI IRIX VTOC VTOC Not supported
Apple Xsan1.3 | VTOC, EFI VTOC, EFI EFI, sVTOC
(MacOS X104
Tiger)

Apple Xsan1.3 | VTOC, EFI VTOC, EFI EFI, sVTOC
(MacOS X 10.3
Panther)?

StorNext 3.1.3 Installation Guide
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Installing the Linux
Kernel Source Code

Verifying Hostname
Length
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Operating Label for Label for Label for
System LUNs<1TB LUNs 1-2 TB LUNs >2TB
Apple Xsan VTOC VTOC sVTOC

1.28

a. Supports only the first 2 TB of LUNs larger than 2 TB.

b. Support for EFI labels requires the Multiterabyte Disk Support patch.
c. Support for 2 TB or larger LUNs requires Solaris 10 Update 2 (06/06).
d. Supports only LUNSs of 2.2 TB or less.

Note: For best results, Quantum recommends using persistent
binding for disk LUNs. For more information, contact the
vendor of your HBA (host bus adapter).

For management servers running Red Hat Enterprise Linux version 4 or
5, before installing SNFS and SNSM you must first install the kernel
header files (shipped as the kernel-devel or kernel-devel-smp RPM,
depending on your Linux distribution).

For servers running SUSE Linux Enterprise Server, you must install the
first kernel source code (shipped as the kernel-source RPM). StorNext
will not operate correctly if these packages are not installed. You can
install the kernel header files or kernel source RPMs by using the
installation disks for your operating system.

The maximum hostname length for a StorNext server is limited to 25
characters. Before you begin the installation, verify that the destination
hostname is not longer than 25 characters. (The hostname is read during
the installation process, and if the hostname is longer than 25 characters
the installation process could fail.)
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Pre-Installation Script

The StorNext pre-installation script (snPrelnstall) is included on the
StorNext installation CD. When you run snPrelnstall, you are prompted
for information about your system. The pre-installation script uses this
information to estimate the amount of local disk space required for SNFS
and SNSM support directories. In addition, the script recommends the
optimal locations for support directories.

StorNext uses five directories to store application support information.
These directories are stored locally on the metadata controller, except for
the Backup directory, which is stored on the managed file system.

The StorNext support directories are described in Table 4.

Table 4 StorNext Support
Directories

Before You Begin

StorNext 3.1.3 Installation Guide

Support Directory

Description

Database

/adic/database

Records information about where and how
data files are stored.

Journal

/adic/database_jnl

Records changes made to the database.

Mapping
/adic/mapping_dir

Contains index information that enables quick
searches on the file system.

Metadata

/adic/database_meta

Stores metadata dumps (backups of file
metadata).

Backup
/backup

Contains configuration files and support data
required for disaster recovery.

Before running the pre-installation script, be prepared to answer the

following questions:

* Is this an upgrade installation?

* What local file systems can be used to store support information?

¢ Which version of StorNext will be installed?

Download from Www.Somanuals.com. All Manuals Search And Download.
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What is the maximum number of directories expected (in millions)?
What is the maximum number of files expected (in millions)?
How many copies will be stored for each file?

How many versions will be retained for each file?

Note: Keep in mind that storage needs typically grow rapidly.

Consider increasing the maximum number of expected
directories and files by a factor of 2.5x to ensure room for
future growth.

Note: The pre-installation script ignores unmounted file systems.

Before running snPrelnstall, be sure to mount all local file
systems that will hold StorNext support information.

Running snPrelnstall

1
2

StorNext 3.1.3 Installation Guide

To run the pre-installation script, use the StorNext installation CD.

Log on to the MDC as root.

Mount the StorNext installation CD and change to the CD root
directory.

List the installation directories on the CD. At the command prompt,
type:
Is -l

Identify the correct installation directory for your operating system
and hardware platform, and then change to that directory.

For example, for Red Hat Linux 4 running on an x86 64-bit platform,
change to the RedHat40AS_26x86_64 directory.

Run the script. At the command prompt, type:
IsnPrelnstall

The pre-installation script runs (figure 1).
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Figure 1 Pre-Installation Script

NOTE:

SPACE:

Aborting:

This script will determine the disk space requirements for
performing a StorNext install/upgrade. It will then report
whether or not the local system has the required disk space
for the operation. Output will be one of these four types:

RECOMMEND: A recommendation of how to set up the

StorNext directories on your system.

An advisory message indicating that the system
can run with the given configuration, at the
desired capacity, but the configuration

is not optimal.

Due to space issues the system cannot be
configured to run at the desired capacity
without adding more disk space.

An error has occured, or invalid input has been
provided, and no further analysis can be done.

The script will exit with one of these values:
0 - disk space fine, ok to proceed with install/upgrade
1 - disk space available, but not optimal file system layout
2 - disk space not available for install/upgrade
3 - invalid args etc. kept script from completing normally

Are you upgrading ?? [y/<n>]:

6 Follow the onscreen instructions, and answer each question when

prompted.

The script outputs results based on the information you entered.

Interpreting snPrelnstall After you enter all requested information, the pre-installation script
Output outputs the following results:

* Estimated disk space required for each support directory.

* Recommended file system location for each support directory.

Tech Tip:

For optimal performance, each support directory
(other than the Backup directory) should be located on
its own local file system, and each local file system
should reside on a separate physical hard disk in the
MDC.

There are three types of directory recommendations, as indicated by the
text preceding the recommendation. The three types of recommendations
are described in Table 5.

StorNext 3.1.3 Installation Guide
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Table 5 Pre-Installation Script T
Recommendation Types ype

Description

RECOMMEND

The suggested directory locations will result in
optimal system performance.

NOTE

The suggested directory locations are valid but
system performance will not be optimal.

SPACE

Additional hard disk space is required to store
the required support directories.

The pre-installation script bases directory location recommendations on

the following criteria:

* To aid disaster recovery, the Database and Journal directories should
be located on different file systems.

* For optimal performance, the Metadata directory should not be

located on the same file system as (in order of priority) the Journal,

Database, or Mapping directory.

Note: Do not change the location of support directories manually.
Instead, use the installation script to specify the location for
support directories. For more information, see StorNext
Installation Script.

StorNext 3.1.3 Installation Guide
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StorNext Installation Script

When you are ready to install StorNext, use the StorNext installation
script to install StorNext File System and Storage Manager on the
metadata controller. The installation script also installs the client software

on the MDC.
Launching the StorNext The StorNext installation script lets you choose installation configuration
Installation Script options and install StorNext. To launch the script, use the correct

StorNext installation CD for your operating system.
1 Log on to the MDC as root.

2 Mount the StorNext installation CD and change to the CD root
directory.

Note: When you mount a CD in a Red hat 4 or 5 system, CDs are
mounted by default with a noexec (non-executable) option
which prevents you from proceeding with the installation.

For Red Hat users only, before proceeding you must
remount the CD by typing mount -o remount, exec ...

3 List the installation directories on the CD. At the command prompt,
type:
Is -l

4 Identify the correct installation directory for your operating system
and hardware platform, and then change to that directory.

For example, for Red Hat Linux 4 running on an x86 64-bit platform,
change to the RedHat40AS_26x86_64 directory.

5 Run the script. At the command prompt, type:
Jinstall.stornext

The installation script runs (figure 2).

StorNext 3.1.3 Installation Guide 12
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Flgurez StorNext Installation Stornmext Install 3.1.3{4) MAIN MERU
Script

11 Installation Configuration
21 Install =tornext
3 Show Status
41 Quit

Enter your choice <2>: I:l

StorNext 3.1.3 Installation Guide
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Table 6 StorNext Installation
Main Menu Options

Changing Installation
Configuration Options

StorNext 3.1.3 Installation Guide
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StorNext Installation Script

6 Type the number corresponding to a menu option and press <Enter>.
Installation menu options are described in Table 6.

Menu Option

Description

1

Change installation options, including the
location of application directories and the
default media type (see Changing Installation
Configuration Options).

Install StorNext using the installation options
specified on the Configuration Menu (see
Performing an Installation Operation on page
17).

View the status of an installation operation that
is currently in progress.

Exit the StorNext installation script.

Use the Configuration Menu to change StorNext installation options. You
can specify the location of application and support directories and change
the default media type for storage devices.

On the Main Menu, type 1 and press <Enter>. The Configuration Menu

appears (figure 3).

14
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Figure 3 Configuration Menu
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Ertornext 2.1.32 (%) Configuration Menu

DESCRIPTION
Perl installation directory

Tertiary Manag in irectory
21 GUI installetion di
1o web installaetion
111 Disk Manage

12) Jadicsdatabase meta Metadumps

1] Jedic/mapping TEM mapping

L4 Jedics/deatebase_jnl Database journal
151 LTO Default media type
Enter number to modify or hit <RETURN> to continue install D

Changing Application Directory Locations

When you first enter the Configuration Menu, it displays recommended
locations for StorNext application directories based on the available file
systems detected by the installation script. To accept the recommended
directory locations and return to the Main Menu, press <Enter>.

Alternately, customize the installation by specifying the file systems
where application and support files are stored.

1 On the Configuration Menu, type the number that corresponds to the
directory location you want to customize (1-14), and then press
<Enter>.

A list of available local file systems is shown.

2 To change the file system where the directory is located, type the
name of the file system and press <Enter>.

15
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3 To confirm the change, type yes and press <Enter>.
To customize additional directory locations, repeat steps 1-3.

4 When you are done customizing the installation, press <Enter> to
return to the Main Menu.

Note: To help determine the optimal location for StorNext support
directories, use the StorNext pre-installation script. For more
information, see Pre-Installation Script on page 8.

Changing the Default Media Type

If you do not specify a different media type, the StorNext installation
script selects LTO as the default media type for storage devices. If storage
devices in your system use a different media type, change the default
media type before installing StorNext.

1 On the Configuration Menu, type 15 and press <Enter>.

A list of valid default media types is shown. The valid media types
are: DDISK, SDISK, LTO, LTOW, 3590, 3592, 9840, 9940, AITW, AIT,
DLT4, and T10K.

Note: The DDISK option is available only for MDCs running
x86 (32-bit or 64-bit) versions of Linux.

2 Type the correct default media type for storage devices in your
system and press <Enter>.

3 To confirm the change, type yes and press <Enter>.

4 When you are done customizing the installation, press <Enter> to
return to the Main Menu.

Note: For multiple libraries or systems with mixed media types,
specify the media type used in the primary backup.

StorNext 3.1.3 Installation Guide 16
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Performing an To install StorNext using the options specified on the Configuration
Installation Operation Menu, perform an installation operation.

1 On the Main Menu, type 2 and press <Enter>.

The StorNext installation script runs (figure 4). The script displays
the current progress of the installation.

Figure 4 StorNext Installation

Etornext Instasll 2.1.3 (8] Etatus
Status
11 Install Pre-Install 3.8 . DB3TR) Complete
21 Install perl B.E.3 F.D.D(23) Complete
3] Instmsll docs 2.8 .DIB3TH) Complete
41 Install PCL 2.0 .00B3TH) Complete
L} Install databases B.9.ZE .98 L.4.3.0D012) Complete
B Install ERWVCLOG 2.2.DLB) Complete
T Instmsll FPEE 2.8 .D(B3TR) Complete
El Install MEM 2.0 .D(B3TH) Complete
91 Imstall TsSM T A.D(B3ITE) Complete
Lo Install www 2.0 D0B3TR) Complete
113 Install spache 2.0.84 Z2.0.84028) Complete
12] Install DEM 2.0 .00B3TH) Complete
13] Install Post-Install Z. 8. 000375 Complete
Hit <RETUEN> to ::m:inue.l
2 When the installation is complete, press <Enter> to return to the Main
Menu.
3 To exit the installation script, type 4 and press <Enter>.
Note: The script displays the URL at which the MDC can be
accessed. Make a note of this information.
You can now access StorNext File System and Storage Manager, and run
the configuration wizard. For more information, see Chapter 4,
“Configuring StorNext.”
StorNext 3.1.3 Installation Guide 17

Download from Www.Somanuals.com. All Manuals Search And Download.



DY ©

Q Installing StorNext File System
m

This chapter describes how to install StorNext File System (SNFS) on a
metadata controller (MDC). Install SNEFS to create data sets that can be
shared by clients and applications running on multiple operating
systems.

To ensure successful operation, do the following tasks before installing
StorNext:

* Make sure the MDC meets all operating system and hardware
requirements (see File System Requirements).

* Make sure all storage devices are correctly configured and are visible
to the MDC (see Getting Ready to Install on page 21).

When you are ready, install StorNext File System on the MDC using the
appropriate method for your operating system (see Installing StorNext
File System on Linux or Unix on page 24 or Installing StorNext File
System on Windows on page 27).

Note: To install both StorNext File System and StorNext Storage
Manager, see Chapter 1, “Installing StorNext File System and
Storage Manager.” To install the StorNext client software, see
Chapter 3, “Installing the StorNext Client.”

StorNext 3.1.3 Installation Guide 18
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File System Requirements

Operating System
Requirements

To run StorNext File System, the metadata controller must meet all
operating system and hardware requirements.

The operating systems, releases and kernels, and hardware platforms
supported by StorNext SNFS are presented in Table 7. Make sure the
MDC uses a supported operating system and platform, and if necessary
update to a supported release or kernel version before installing

StorNext.

Table 7 File System
Supported Platforms

StorNext 3.1.3 Installation Guide

Operating System Release or Kernel Platform
Windows 2003 Server SP2 x86 32-bit
x86 64-bit
Windows 2008 Server SP1 x86 32-bit
x86 64-bit
Red Hat Enterprise 2.6.9-55.EL (Update 5) x86 32-bit
Linux 4 x86 64-bit
2.6.9-67 EL (Update 6) Itanium 64-bit
2.6.9-78.EL (Update 7)
Red Hat Enterprise 2.6.18-53.EL (Update 1) x86 64-bit
Linux5 2.6.18-92.EL (Update 2)
SUSE Linux Enterprise | 2.6.16.21-0.8 x86 32-bit
Server 10 x86 64-bit
2.6.16.46-0.12 (SP1) Itanium 64-bit
2.6.16-60-0.27 (SP2)
Sun Solaris 10 Generic 120011-14 SPARC 64-bit
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Hardware Requirements

Table 8 File System Hardware
Requirements

LAN Requirements

StorNext 3.1.3 Installation Guide
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The minimum amount of RAM and available hard disk space required to
run StorNext SNFS are presented in Table 8.

If necessary, upgrade the RAM and local disk storage in the MDC to meet
the minimum requirements before installing StorNext.

Note: The RAM requirements in Table 8 are for running StorNext
File System only. Running additional software (including the
StorNext client software) requires additional RAM.

File Systems RAM Disk Space
1-4* 2GB 2GB
5-8** 4GB 4GB

* Two CPUs recommended for best performance.
** Two CPUs required for best performance.

Note: On 32-bit versions of Windows, for best performance, run
SNEFS on a dedicated system. Do not run other applications on
the MDC.

The following LAN requirements must be met before installing StorNext
on the MDC:

* In cases where gigabit networking hardware is used and maximum
StorNext performance is required, a separate, dedicated switched
Ethernet LAN is recommended for the StorNext metadata network. If
maximum StorNext performance is not required, shared gigabit
networking is acceptable.

* A separate, dedicated switched Ethernet LAN is mandatory for the
metadata network if 100 Mbit/s or slower networking hardware is
used.

e The MDC and all clients must have static IP addresses.

Verify network connectivity with pings, and also verify entries in the
letc/hosts file.

20
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* If using Gigabit Ethernet, disable jumbo frames and TOE (TCP
offload engine).

Note: StorNext does not support file system metadata on the same
network as iSCSI, NFS, CIFS, or VLAN data when 100 Mbit/s
or slower networking hardware is used.

Getting Ready to Install

Before installing StorNext SNFS, complete the following tasks to ensure
successful installation:

* Correctly configure all storage devices (see Configuring Storage
Devices on page 21).

* If using LUNSs larger than 1 TB, decide on a label type and install any
necessary operating system patches (see Planning for LUNs Larger
than 1 TB on page 22).

* (Linux only) Install the kernel source code (see Installing the Linux
Kernel Source Code on page 23).

Configuring Storage Before installing StorNext SNFS, make sure that all LUNSs are visible to
Devices the MDC. (A LUN, or logical unit number, is a logical device that
corresponds to one or more disks, drives, or storage devices.)

If there are any connection issues, resolve them before installing
StorNext. For assistance in configuring storage devices, refer to the
documentation that came with the storage device, or contact the
manufacturer.

Note: LUNSs that you plan to use in the same stripe group must be
the same size. Consider this when configuring storage devices.
(For more information about stripe groups, see the StorNext
3.1.3 User’s Guide.)

StorNext 3.1.3 Installation Guide 21
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Caution:  StorNext does not support the connection of multiple
devices through fibre channel hubs. Multiple devices must
be connected using fibre channel switches.

Planning for LUNs Larger

than 1 TB

StorNext supports LUNs greater than 1 TB in size if they are allowed by
the operating system. To enable support for 1 TB or larger LUNSs, all
StorNext LUNs must be correctly labeled according to the requirements
of the operating system running on the MDC as well as the operating
system running on all connected clients. Disk LUNs can have one of three
labels: VTOC, EFI, or sVTOC (short VTOC).

Required disk LUN label settings based on operating system and LUN
size are presented in Table 9. Before installing StorNext, decide what
label type will be used, and then install any required operating system
patches or updates (for both MDC and client) as indicated in the notes for

Table 9.

Note: After labeling a disk LUN, you must reboot systems running
Solaris before they can access the disk LUN.

Table 9 Required Disk LUN

Labels

StorNext 3.1.3 Installation Guide

Operating Label for Label for Label for
System LUNs<1TB LUNs 1-2 TB LUNs >2 TB
Windows XP? VTOC, EFI VTOC, EFI EFI, sVTOC
Windows 2003 | VTOC, EFI VTOC, EFI EFI, sVTOC
Server

Linux 2.6 VTOC, EFI VTOC, EFI EFI, sVTOC
Kernel

Linux 2.4 VTOC, EF1 VTOC, EFI Not supported
Kernel

Solaris 9° VTOC, EFI EFI Not supported
Solaris 10¢ VTOC, EFI EFI EFI

HP-UX? VTOC, EFI VTOC, EFI EFI, sVTOC
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Operating Label for Label for Label for
System LUNs<1TB LUNs 1-2 TB LUNs >2TB
IBM AIX4 VTOC, EFI VTOC, EFI EFI, sVTOC
SGI IRIX VTOC VTOC Not supported
Apple Xsan 1.3 | VTIOC, EFI VTOC, EFI EFI, sVTOC
(MacOS X 10.4

Tiger)

Apple Xsan1.3 | VIOC, EFI VTOC, EFI EFI, sVTOC
(MacOS X 10.3

Panther)?

Apple Xsan VTOC VTOC sVTOC

1.22

a. Supports only the first 2 TB of LUNs larger than 2 TB.

b. Support for EFI labels requires the Multiterabyte Disk Support patch.
c. Support for 2 TB or larger LUNs requires Solaris 10 Update 2 (06/06).
d. Supports only LUNSs of 2.2 TB or less.

Note: For best results, Quantum recommends using persistent
binding for disk LUNs. For more information, contact the
vendor of your HBA (host bus adapter).

Installing the Linux
Kernel Source Code

StorNext 3.1.3 Installation Guide

For MDCs running Red Hat Linux or SUSE Linux Enterprise Server you
must install the kernel source code as well as all tools required to compile
the kernel before installing SNFS. StorNext will not operate correctly if
the kernel source code is not installed.

The kernel source code can be installed using the installation disks for
your operating system.

23
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Installing StorNext File System on Linux or Unix

When you are ready to install StorNext, use the SNFS installation script to
install StorNext File System on a metadata controller running Linux or
Unix. The installation script also installs the client software on the MDC.

StorNext can be installed on any local file system (including the root file
system) on the MDC. However, for optimal performance, avoid installing
StorNext on the root file system.

Launching the SNFS The SNFS installation script lets you choose installation configuration
Installation Script options and install StorNext. To launch the script, use the correct
StorNext installation CD for your operating system.

1 Log on to the MDC as root.

2 Mount the StorNext installation CD and change to the CD root
directory.

Note: When you mount a CD in a Red hat 4 or 5 system, CDs are
mounted by default with a noexec (non-executable) option
which prevents you from proceeding with the installation.

For Red Hat users only, before proceeding you must
remount the CD by typing mount -o remount, exec ...

3 List the installation directories on the CD. At the command prompt,
type:
Is -l

4 Identify the correct installation directory for your operating system
and hardware platform, and then change to that directory.

For example, for Red Hat Linux 4 running on an x86 64-bit platform,
change to the RedHat40AS_26x86_64 directory.

5 Run the script. At the command prompt, type:
Jinstall.snfs

The installation script runs (figure 5).
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Figure 5 SNFS Installation Snfs Install 3.1.3(4) MAIN MENU

Script ) ) )
1) Installation Configuration

2) Install snfs

3) Show Status

4) Quit

Enter your choice <2»:

6 Type the number corresponding to a menu option and press <Enter>.
Installation menu options are described in Table 10.

Table 10 SNFS Installation

Main Menu Options Menu Option Description

1 Change installation options for the location of
application directories (see Changing
Installation Configuration Options on page 25).

2 Install StorNext using the installation options
specified on the Configuration Menu (see
Performing an Installation Operation on page
26).

3 View the status of an installation operation that
is currently in progress.

4 Exit the SNFS installation script.
Changing Installation Use the Configuration Menu to change the location of application
Configuration Options directories.

On the Main Menu, type 1 and press <Enter>. The Configuration Menu
appears (figure 6).
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Figure 6 Configuration Menu Snfs 3.1.3(5) Configuration Menu
_ VALUE _ DESCRIPTION
1) /usr/adic/perl Perl installation directory
2) Jusr/adic/docs Docs installation directory
3) Jusr/adic/PSE Pse installation directory
4y  Jusr/adic/www GUI installation directory
5) fusr/adic/apache Web installation directory
&) Jusr/cvis Disk Manager installation directory

Enter number to modify or hit <RETURN> to continue install D

When you first enter the Configuration Menu, it displays recommended
locations for StorNext application directories based on the available file

systems detected by the installation script. To accept the recommended

directory locations and return to the Main Menu, press <Enter>.

Alternately, customize the installation by specifying the file systems
where application and support files are stored.

1 On the Configuration Menu, type the number that corresponds to the
directory location you want to customize (1-6), and then press
<Enter>.

A list of available local file systems is shown.

2 To change the file system where the directory is located, type the
name of the file system and press <Enter>.

3 To confirm the change, type yes and press <Enter>.
To customize additional directory locations, repeat steps 1-3.

4 When you are done customizing the installation, press <Enter> to
return to the Main Menu.

Performing an _ To install StorNext using the options specified on the Configuration
Installation Operation Menu, perform an installation operation.

1 On the Main Menu, type 2 and press <Enter>.

The installation script runs (figure 7). The script displays the current
progress of the installation.
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Figure 7 StorNext Installation Snfs Install 3.1.3(5) Status

Status
1) Install Pre-Install 3.5.0(6375) Complete
2} Install perl 5.8.3 3.0.0(23) Complete
3) Install docs 3.5.0(6375) Complete
4) Install PSE 3.5.0({8375) Complete
5) Install www 3.5.0(6375) Complete
G) Install apache 2.0.54 2.0.54(25) Complete
7) Install DsSM 3.5.0(6375) Complete
8) Install Post-Install 3.3.0(63753) Complete

Hit <RETURN> to continue.]]

2 When the installation is complete, press <Enter> to return to the Main
Menu.

3 To exit the installation script, type 4 and press <Enter>.

Note: The script displays the URL at which the MDC can be
accessed. Make a note of this information.

You can now access StorNext File System and run the configuration
wizard. For more information, see Chapter 4, “Configuring StorNext.”

Installing StorNext File System on Windows

The StorNext setup wizard guides you through the process of installing
StorNext File System on a metadata controller running Windows 2003
Server. (The installation wizard also installs the client software on the
MDC))

Before installing StorNext, remove any previously installed versions (see
Removing a Previous Version of StorNext on page 28).

When you are ready, use the setup wizard to install StorNext (see
Running the Setup Wizard on page 29).

(Optional) After installation, restore the previous client configuration (see
Restoring a Previous Client Configuration on page 33).
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Note: You must log on as an Administrator to install StorNext.

Removing a Previous
Version of StorNext

Figure 8 StorNext Installation
Window: Remove StorNext

StorNext 3.1.3 Installation Guide

If a previous version of StorNext exists on the system, you must remove it
before installing the new version.

1 Insert the StorNext installation CD.

2 Browse to the root directory of the installation CD and double-click

the file SnfsSetup32.exe (32-bit systems) or SnfsSetup64.exe (64-bit
systems).

The StorNext Installation window appears (figure 8).

2 stomextwsatonon =g
| g | Install StorNext
Curment version must be removed first.
|
=N Remove StorMext
!:’\ Removes StorMex file system
-
([ &a Configure StorMext
nR
Corfigure StorMext.
4|
Exit

Click Remove StorNext.

A dialog box appears informing you that the current client
configuration has been saved.

Note the name and location of the saved configuration file, and then
click OK.

If prompted, click Yes to continue, and then click OK to finish the
removal.

When the removal is complete, click Yes to reboot the system.
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Note: After installing the new version of StorNext, you can restore
the saved client configuration (see Restoring a Previous Client

Configuration on page 33).

Running the Setup To launch the setup wizard, use the correct StorNext installation CD for
Wizard your operating system.

1 Insert the StorNext installation CD.

2 Browse to the root directory of the installation CD and double-click
the file SnfsSetup32.exe (32-bit systems) or SnfsSetup64.exe (64-bit
systems).

The StorNext Installation window appears (figure 9).

Figure 9 StorNext Installation & storext Installation P [ 1
Window: Install StorNext
Quantum.
C.‘:\ Install StorNext
;" Installs StorMext file system

| | Remove StorNext

| StorMesd is not installed.
| Configure StorMext
@ StorMesd is not installed.

3 Click Install StorNext to begin installation.

The StorNext setup wizard appears (figure 10).
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Figure 10 SNFS Setup:
Welcome

{& Storlext File System Setup

Welcome to the StorNext File
System Setup Wizard

The Setup Wizard will install StorNext File System on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard,

= Back Cancel

4 Click Next to continue.

The License Agreement window appears (figure 11).

Figure 11 SNFS Setup: End-
User License Agreement

i'é“ Storlext File System License Agreement |

End-User License Agreement

Please read the following license agreement carefully

Quantum Corporation End User License Agreement
This License defines the terms and conditions of the license between
QUANTUM and Licensee foruse of QUANTUM software and related
documentation. Any software or related materials provided to Licensee by
QUANTUM will be subject to the terms and conditions of this License
and by opening the accompanying package and/or by using the products.
Licensee signifies its agreement with this license.

1. Software License.
(a) Licemss In consideration of Licensee's pavment of the License fees

and subject to the terms of this License, QUANTUM grants to Licensee a LI

% I accept the terms in the License Agreement:

" I do not accept the terms in the License Agreement

< Back I Next > I

Cancel |

5 Click the option to accept the license agreement, and then click Next
to continue.

The Customer Information window appears (figure 12).
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Figure 12 SNFS Setup: xl
Customer Information Customer Information

Flease enter your customer information

User Name:
IJanE Smith

Organization:
Jauantum

< Back I Next = I Cancel |

6 Type your name and the name of your company or organization in
the boxes, and then click Next to continue.

The Choose Setup Type window appears (figure 13).

Figure 13 SNFS Setup: l
Choose Setup Type Choose Setup Type

Choose the setup type that best suits your needs

Typical

Installs the most common program features. Recommended for
most users,

Custom

Allows users to choose which program features will be installed
and where they will be installed. Recommended for advanced
users.,

Complete
All program features will be installed. {(Requires most disk
space)

< Back et = Cancel

7 Click an installation option:

* Typical: (Recommended) Installs StorNext File System, client
software, and help files in the default location (C:\Program
Files\StorNext).
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* Custom: Lets you choose which components to install and specify
an installation location. When ready, click Next.

* Complete: Same as a typical installation.

The Ready to Install window appears (figure 14).

Figure 14 SNFS Setup: Ready x
to Insta” Ready to Install

The Setup Wizard is ready to begin the Typical installation

Click Install to begin the installation. If you want to review or change any of your
installation settings, dlick Back. Click Cancel to exit the wizard.

Cancel

8 Click Install to continue.

Wait while the setup wizard installs StorNext. When installation is
complete, the Finish window appears (figure 15).

Figure 15 SNFS Setup: Finish ﬂ

Completing the StorNext File
System Setup Wizard

Click the Finish button to exit the Setup Wizard.

Cancel
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9 Click Finish to close the setup wizard.
10 On the StorNext Installation window, click Exit.
You are prompted to reboot the system.
11 Click Yes to reboot.

You can now configure StorNext File System. For more information, see
Chapter 4, “Configuring StorNext.” Or, to restore a previous client
configuration, see the next section.

Restoring a Previous If you saved a client configuration file (for example, when removing a

Client Configuration previous version of StorNext), you can import it after installing StorNext.
This configures StorNext using the same settings as the previous
installation.

1 Insert the StorNext installation CD.

2 Browse to the root directory of the installation CD and double-click
the file SnfsSetup32.exe (32-bit systems) or SnfsSetup64.exe (64-bit
systems).

The StorNext Installation window appears (figure 16).

Figure 16 StorNext Installation g [=[ 3
Window: Configure StorNext
Quantum.
@\ Reinstall StorNext
= Updates StorMest file system
A 4
| & | Remove StorNext
A Removes StorNext file system
€
( ) Configure StorNext
‘.J Corffigure StorMext.
Exit

3 Click Configure StorNext.
The StorNext Configuration window appears (figure 17).
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Figure 17 StorNext stomext Confouraton l
Configuration Window
Quantum.

Name Servers

Configure StorMext name servers

Label Disk Drives
Format Drives with StorNext Label,

Simple Server Configuration
Create a basic StorMext file system,

Import/Export Client Settings

Import/Export StorMext client registry settings
from/fto a file.

Client Configuration

Sl Al =)L

Configure drive mappings and other StorMext
dient options.

4 Click Import/Export Client Settings.

The Import/Export Client Configuration window appears (figure 18).
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|
Quantum.

~ Export

Export StorMext Client registry settings to a file.

Client configuration export file:

Browse. .. |
Export |

 Import

Import StorMext Client registry settings from a file.

Client configuration file to import:

Browse... |

Discard current configuration and replace it with the Import File or merge Import File
with current configuration?

¥ Merge with current configuration

£~ Replace current configuration

Import |

Under Import, click Browse. Locate the client configuration (*.reg) file
to import, and then click Open.

Client configuration files saved during removal of a previous version
of StorNext are located in one the following directories:

e C:\SNFS\config\
* C:\Program Files\StorNext\config\
Click an option for handling current configuration settings:

* Merge with current configuration: The imported configuration is
merged with the current configuration settings.

* Replace current configuration: The imported configuration
overwrites the current configuration settings.

Click Import, and then click Yes to confirm.

A message appears informing you the configuration settings were
successfully added to the registry.

Click OK, and then click Quit to close the Import/Export Client
Configuration window.
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Q Installing the StorNext Client
m

This chapter describes how to install the StorNext client software. The
StorNext client software lets you mount and work with StorNext file
systems.

To ensure successful operation, make sure the client system meets all
operating system and hardware requirements (see Client System

Requirements).
To install the StorNext client software, first download the client software

from the metadata controller (MDC) (see Downloading the StorNext
Client Software on page 39).

After downloading the client software, install and configure it using the
appropriate method for your operating system (see Installing the
StorNext Client on Linux or Unix on page 42 or Installing the StorNext
Client on Windows on page 51).

Note: Before installing the StorNext client software, you must install
and configure StorNext on an MDC. For more information, see
Chapter 1, “Installing StorNext File System and Storage
Manager” or Chapter 2, “Installing StorNext File System.”
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Client System Requirements

Operating System
Requirements

To run the StorNext client software, the client system must meet all
operating system and hardware requirements.

The operating systems, releases and kernels, and hardware platforms
supported by the StorNext client software are presented in Table 11.
Make sure the client system uses a supported operating system and
platform, and if necessary update to a supported release or kernel version

before installing StorNext.

Table 11  StorNext Client
Supported Platforms

StorNext 3.1.3 Installation Guide

Operating System Release or Kernel Platform
Windows XP SP2 x86 32-bit
Sp3 x86 64-bit
Windows 2003 Server SP2 x86 32-bit
x86 64-bit
Windows Vista SP1 x86 32-bit
x86 64-bit
Red Hat Enterprise 2.6.9-55.EL (Update 5) x86 32-bit
Linux 4 x86 64-bit
2.6.9-67.EL (Update 6) Itanium 64-bit
2.6.9-78.EL (Update 7)
Red Hat Enterprise 2.6.18-53.EL (Update 1) x86 64-bit
Linux5 2.6.18-92.EL (Update 2)
SUSE Linux Enterprise | 2.6.16.21-0.8 x86 32-bit
Server 10 x86 64-bit

2.6.16-46-0.12 (SP1)
2.6.16-60-0.27 (SP2)

Itanium 64-bit

Sun Solaris 9

SPARC 64-bit
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Operating System Release or Kernel Platform
Sun Solaris 10 Generic 120011-14 SPARC 64-bit
Generic 127128-11 Opteron and

Intel x86 64-bit

HP-UX 11i v2 [tanium 64-bit

IBM AIX 53 64-bit Power
Architecture

SGI-IRIX 6.5.30 64-bit MIPS

Apple MacOS X 10.5 With Xsan 1.4.2 or Xsan x86 32-bit
211

To install and run the StorNext client software, the client system must
meet the following minimum hardware requirements.

For SAN (FC-attached) clients or for distributed LAN clients:
* 1GBRAM
* 500 MB available hard disk space
For SAN clients acting as a distributed LAN server:
* 2GBRAM
* 500 MB available hard disk space

Hardware Requirements

Note: Distributed LAN servers may require additional RAM
depending on the number of file systems, distributed LAN
clients, and NICs used. See the StorNext 3.1.3 Release Notes for
distributed LAN server memory tuning guidelines.
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Downloading the StorNext Client Software

The StorNext client software can be downloaded from a metadata
controller. (To download the client software, the client system must have
network access to the MDC.)

Note: You can download the client software only from MDCs
running Linux or Unix.

1 On the client system, point a web browser to the URL (host name and
port number) of the MDC. For example, http://servername:81

Use one of the following web browsers to access the MDC (make sure
pop-up blockers are turned off):

* Internet Explorer 6.0 or later (including 7.0)
* Mozilla Firefox 1.5 or later (including 2.0 or later)

2 When prompted, type the username and password for the MDC, and
then click OK. (The default value for both username and password is
admin.)

The StorNext home page appears.
3 Do one of the following:

*  For a MDC running SNFS and SNSM: On the Admin menu, click
Download Client Software.

*  For a MDC running SNFS only: On the home page, click
Download Client Software.

The Select Platform window appears (figure 19).
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Figure 19 Select Platform /3 Download Client Software - Microsoft Internet Explorer =lol =]
Window =

Platform

Quantum.

Download the SNFS client for a supported platform.

If the client is already installed and the version of the client on

= the server is newer than the version on the client, the client
“ installation will be upgraded.
File SYste | Selact the appropriate platform.

| « || Next b | | X cancel |

[]

4 In the list, click the operating system running on the client system,
and then click Next.

The Download Client Software window appears (figure 20).
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2} Download Client Software - Microsoft (=] ]

Download Client Software

Quantum. Download the DSM client for the Linux platform.

— — Select the processor on the client machine. Select the download
| location and file name for use in the next step.

I/Fﬂ location for the file. This can be any temporary location. MNote the

r

File SYS™ | | i Redhat AS 4.0 (32-hit)
———~" | Linux Redhat AS 4.0 (64-bit)
Linux Redhat AS 4.0 (iab4)
Linux Redhat AS 5.0 (64-bit)
Linux SuSE ES 10.0 (32-bit)
Linux SuSE ES 10.0 (64-bit)
Linux SuSE ES 10.0 (ia64)

| 4 Back | | Next b | | % cancel |

-]

5 Click the download link that corresponds to your operating system

version and hardware platform. (Depending on the operating
system, you may have only one choice.)

For example, for Red Hat Linux 4 running on an x86 64-bit platform,
click Linux Redhat AS 4.0 (Intel 64bit).

When prompted, click Save or OK to download the file to the client
system.

Make sure to note the file name and the location where you save the
file.

After the download is complete, click Cancel to close the Download
Client Software window.

Do not follow the onscreen installation instructions. Instead, continue
with the correct procedure for your operating system:

* Installing the StorNext Client on Linux or Unix on page 42

* Installing the StorNext Client on Windows on page 51.

41

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 3 Installing the StorNext Client
Installing the StorNext Client on Linux or Unix

Installing the StorNext Client on Linux or Unix

After downloading the StorNext client software from the metadata
controller, install it on the client system using the correct procedure for
your operating system:

Installing the StorNext Client on Linux on page 42

Installing the StorNext Client on Sun Solaris on page 44

Installing the StorNext Client on HP-UX on page 46

Installing the StorNext Client on IBM AIX on page 47

Installing the StorNext Client on SGI IRIX on page 49

Installing the StorNext To run the StorNext client software on Red Hat Linux or SUSE Linux
Client on Linux Enterprise, first install the client software package, and then configure the
client.

Caution:  Before installing the StorNext client software, you must

install the kernel source code. You can install the kernel
source code by using the installation disks for your
operating system.

StorNext 3.1.3 Installation Guide

Log on to the client system as root.

Change to the directory where the client software archive file you
downloaded from the MDC is located.

Extract the software archive file. At the command prompt, type:
tar xf <archive name>

where <archive name> is the name of the software archive file you
downloaded from the MDC.

List the packages extracted from the software archive file. At the
command prompt, type:

Is -l

Identify the correct package to install. The correct package begins
with snfs-client and ends with the .rpm file name extension.

42
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Note: The file that ends with .rpm.md5sum is a checksum file, not
the client software package.

5 Install the client software package. At the command prompt, type:
rpm -ivh <package name>

where <package name> is the name of the client software package you
identified in step 4.

6 Configure the boot order for system services. Do one of the following:
* For Red Hat Linux, at the command prompt, type:
chkconfig --level 3456 cvfs on
* For SUSE Linux Enterprise, at the command prompt, type:
chkconfig -s raw 235
chkconfig -s cvfs 345

7 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP
address of the MDC the client will connect to.

The fsnameservers file on the client must be exactly the same as on
the MDC. If the fsnameservers file does not exist, use a text editor to
create it.

Note: The fsnameservers file only needs to contain the name of
the MDC. For example, if the MDC is named snserver, then
the fsnameservers file should contain a single line with a
single word: snserver

8 Create a mount point for the file system. At the command prompt,
type:
mkdir -p <mount point>
chmod 777 <mount point>

where <mount point> is the directory path where you want the file
system to be mounted. For example: /stornext/snfs1
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Configure the file system to automatically mount after reboot. To do
this, edit the /etc/fstab file so that it contains the following line:

<file system> <mount point> cvfs verbose=yes 0 0

where <file system> is the name of the StorNext file system and <mount
point> is the directory path created in step 8.

Reboot the client system.

After reboot, the StorNext file system is mounted at the mount point
you specified.

Note: To manually mount a file system, at the command prompt,

type:
mount -t cvfs <file system> <mount point>

where <file system> is the name of the StorNext file system and
<mount point> is the directory path where you want the file
system to be mounted.

Installing the StorNext To run the StorNext client software on Sun Solaris, first install the client
Client on Sun Solaris software package, and then configure the client.

1
2
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Log on to the client system as root.

Change to the directory where the client software archive file you
downloaded from the MDC is located.

Extract the software archive file. At the command prompt, type:
tar xf <archive name>

where <archive name> is the name of the software archive file you
downloaded from the MDC.

Install the client software package. At the command prompt, type:
pkgadd -d .
Type 1 to select the ADICsnfs package.

Typey to confirm installation of the ADICsnfs package. When
installation is complete, type q to quit the installation program.
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7 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP
address of the MDC the client will connect to.

The fsnameservers file on the client must be exactly the same as on
the MDC. If the fsnameservers file does not exist, use a text editor to
create it.

Note: The fsnameservers file only needs to contain the name of
the MDC. For example, if the MDC is named snserver, then
the fsnameservers file should contain a single line with a
single word: snserver

8 Create a mount point for the file system. At the command prompt,
type:
mkdir -p <mount point>
chmod 777 <mount point>

where <mount point> is the directory path where you want the file
system to be mounted. For example: /stornext/snfs1

9 Configure the file system to automatically mount after reboot. To do
this, edit the /etc/vfstab file so that it contains the following line:

<file system> - <mount point> cvfs 0 auto rw

where <file system> is the name of the StorNext file system and <mount
point> is the directory path created in step 8.

10 Reboot the client system.

After reboot, the StorNext file system is mounted at the mount point
you specified.

Note: To manually mount a file system, at the command prompt
type:
mount -F cvfs <file system> <mount point>
where <file system> is the name of the StorNext file system and

<mount point> is the directory path where you want the file
system to be mounted.
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Installing the StorNext To run the StorNext client software on HP-UX, first install the client
Client on HP-UX software package, and then configure the client.

1
2
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Log on to the client system as root.

Change to the directory where the client software archive file you
downloaded from the MDC is located.

Extract the software archive file. At the command prompt, type:
tar xf <archive name>

where <archive name> is the name of the software archive file you
downloaded from the MDC.

List the packages extracted from the software archive file. At the
command prompt, type:

Is -l

Identify the correct package to install. The correct package begins
with snfs-client and ends with the .depot file name extension.

Install the client software package. At the command prompt, type:
swinstall -s <package path and name> -x mount_all_filesystems=false \*

where <package path and name> is the full path and name of the client
software package you identified in step 4.

Edit the /usr/cvfs/config/fsnameservers text file to contain the IP
address of the MDC the client will connect to.

The fsnameservers file on the client must be exactly the same as on
the MDC. If the fsnameservers file does not exist, use a text editor to
create it.

Note: The fsnameservers file only needs to contain the name of
the MDC. For example, if the MDC is named snserver, then
the fsnameservers file should contain a single line with a
single word: snserver
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7 Create a mount point for the file system. At the command prompt,
type:
mkdir -p <mount point>
chmod 777 <mount point>

where <mount point> is the directory path where you want the file
system to be mounted. For example: /stornext/snfs1

8 Configure the file system to automatically mount after reboot. To do
this, edit the /etc/fstab file so that it contains the following line:

<mount point> <mount point> cvfs rw,fsname=<file system> 0 0

where <mount point> is the directory path created in step 7 and <file
system> is the name of the StorNext file system.

9 Reboot the client system.

After reboot, the StorNext file system is mounted at the mount point
you specified.

Note: To manually mount a file system, at the command prompt,
type:
mount -F cvfs <mount point> <mount point>

where <mount point> is the directory path where you want the
file system to be mounted.

Installing the StorNext To run the StorNext client software on IBM AIX, first install the client
Client on IBM AIX software package, and then configure the client.

1 Log on to the client system as root.

2 Change to the directory where the client software archive file you
downloaded from the MDC is located.

3 Extract the software archive file. At the command prompt, type:
tar xf <archive name>

where <archive name> is the name of the software archive file you
downloaded from the MDC.
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4 List the packages extracted from the software archive file. At the
command prompt, type:

Is -l

Identify the correct package to install. The correct package begins
with snfs and ends with the .bff file name extension.

5 Install the client software package. At the command prompt, type:
installp -ac -d <package name> all .

where <package name> is the name of the client software package you
identified in step 4.

6 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP
address of the MDC the client will connect to.

The fsnameservers file on the client must be exactly the same as on
the MDC. If the fsnameservers file does not exist, use a text editor to
create it.

Note: The fsnameservers file only needs to contain the name of
the MDC. For example, if the MDC is named snserver, then
the fsnameservers file should contain a single line with a
single word: snserver

7 Create a mount point for the file system. At the command prompt,
type:
mkdir -p <mount point>
chmod 777 <mount point>

where <mount point> is the directory path where you want the file
system to be mounted. For example: /stornext/snfs1

8 Configure the file system to automatically mount. At the command
prompt, type:

crfs -v cvfs -d <file system> -a verbose=yes -a type=cvfs -A yes -m <mount
point>

where <file system> is the name of the StorNext file system and <mount
point> is the directory path created in step 7.

The StorNext file system is mounted at the mount point you
specified.
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Note: To manually mount a file system, at the command prompt,

type:
mount <mount point>

where <mount point> is the directory path where you want the
file system to be mounted.

Installing the StorNext To run the StorNext client software on SGI IRIX, first install the client
Client on SGI IRIX software package, and then configure the client.
1 Log on to the client system as root.
2 Change to the directory where the client software archive file you
downloaded from the MDC is located.
3 Extract the software archive file. At the command prompt, type:
tar xf <archive name>
where <archive name> is the name of the software archive file you
downloaded from the MDC.
4 Install the client software package. At the command prompt, type:
inst - .
5 Type go to confirm installation. When installation is complete, type
quit to quit the installation program.
6 Configure the boot order for system services. At the command
prompt, type:
chkconfig cvfs on
chkconfig verbose on
7 Edit the /usr/cvfs/config/fsnameservers text file to contain the IP

StorNext 3.1.3 Installation Guide

address of the MDC the client will connect to.

The fsnameservers file on the client must be exactly the same as on
the MDC. If the fsnameservers file does not exist, use a text editor to
create it.
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Note: The fsnameservers file only needs to contain the name of
the MDC. For example, if the MDC is named snserver, then
the fsnameservers file should contain a single line with a
single word: snserver

8 Create a mount point for the file system. At the command prompt,
type:
mkdir -p <mount point>
chmod 777 <mount point>

where <mount point> is the directory path where you want the file
system to be mounted. For example: /stornext/snfs1

9 Configure the file system to automatically mount after reboot. To do
this, edit the /etc/fstab file so that it contains the following line:

<file system> <mount point> cvfs verbose=yes 0 0

where <file system> is the name of the StorNext file system and <mount
point> is the directory path created in step 8.

10 Reboot the client system.

After reboot, the StorNext file system is mounted at the mount point
you specified.

Note: To manually mount a file system, at the command prompt,
type:
mount -t cvfs <file system> <mount point>
where <file system> is the name of the StorNext file system and

<mount point> is the directory path where you want the file
system to be mounted.
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Installing the StorNext Client on Windows

The StorNext setup wizard guides you through the process of installing
the StorNext client software on Windows XP, Windows 2003 Server, or
Windows Vista.

Before installing StorNext, remove any previously installed versions (see
Removing a Previous Version of StorNext on page 51).

When you are ready, use the setup wizard to install StorNext (see
Running the Setup Wizard on page 52).

(Optional) After installation, restore the previous client configuration (see
Restoring a Previous Client Configuration on page 56).

Note: You must log on as an Administrator to install StorNext.

If you are installing on Windows Vista, answer Yes to any
messages asking if you want to run the installation process
with administrative privileges.

Removing a Previous If a previous version of StorNext exists on the system, you must remove it
Version of StorNext before installing the new version.

1 Unzip the client software archive file you downloaded from the
MDC.

2 Open the unzipped folder and double-click the client software
installer file. This file is named SnfsSetup32.exe (32-bit systems) or
SnfsSetup64.exe (64-bit systems).

The StorNext Installation window appears (figure 21).
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Figure 21 StorNext Installation
Window: Remove StorNext
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& stortext nstalabon JA1=IE

Quantum.

| g | Install StorNext
Curment version must be removed first.
|

=N Remove StorNext
@’\ Removes StorMext file system
n:
([ &a Configure StorMext

AT

Corfigure StorMext.

|
Exit

3 Click Remove StorNext.

A dialog box appears informing you that the current client
configuration has been saved.

4 Note the name and location of the saved configuration file, and then
click OK.

5 If prompted, click Yes to continue, and then click OK to finish the
removal.

6 When the removal is complete, click Yes to reboot the system.

Note: After installing the new version of StorNext, you can restore

the saved client configuration (see Restoring a Previous Client

Running the Setup
Wizard

StorNext 3.1.3 Installation Guide

Configuration on page 56).

To launch the setup wizard, use the correct StorNext installation CD for
your operating system, or use the client software installer you
downloaded from the MDC.

1 If necessary, unzip the client software archive file you downloaded
from the MDC.

2 Open the unzipped folder and double-click the client software
installer file. This file is named SnfsSetup32.exe (32-bit systems) or
SnfsSetup64.exe (64-bit systems).

The StorNext Installation window appears (figure 22).
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Figure 22 StorNext Installation I [=] o
Window: Install StorNext
Quantum.

Install StorNext
Installs StorMext file system

@
| | Remove StorNext
StorMesd is not installed.

Configure StorNext
StorNexd is not installed.

3 Click Install StorNext to begin installation.

The StorNext setup wizard appears (figure 23).

{& Storlext File System Setup x|

Welcome to the StorNext File
System Setup Wizard

Figure 23 SNFS Setup:
Welcome

The Setup Wizard will install StorNext File System on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard,

= Back Cancel

4 Click Next to continue.

The License Agreement window appears (figure 24).
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Figure 24 SNFS Setup: End- x

User License Agreement End-User License Agreement

Flease read the following license agreement carefully

-

Quantum Corporation End User License Agreement
This License defines the terms and conditions of the license between

QUANTUM and Licensee for use of QUANTUM software and related
documentation. Any software or related materials provided to Licensee by
QUANTUM will be subject to the terms and conditions of this License
and by opening the accompanying package and or by using the products,
Licensee signifies its agreement with this license.
1. Software License.

{a) Licemse In consideration of Licensee's pavment of the License fees
and subject to the terms of this License, QUANTUM grants to Licenseea |

% 1 accept the terms in the License Agreement:

~ I do not accept the terms in the License Agreement

< Back I Next = I Cancel |

5 Click the option to accept the license agreement, and then click Next
to continue.

The Customer Information window appears (figure 25).

Figure 25 SNFS Setup: x

Customer |nf0rmati0n Customer Information

Please enter your custamer information

User Mame:
IJanE Smith

Organization:
IQuantum

< Back I Next > I Cancel |

6 Type your name and the name of your company or organization in
the boxes, and then click Next to continue.

The Choose Setup Type window appears, (figure 26).
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Figure 26 SNFS Setup: l
Choose Setup Type Choose Setup Type

Choose the setup type that best suits your needs

Typical

Installs the most comman program features. Recommended for
most users,

Custom

Allows users to choose which program features will be installed
and where they will be installed. Recommended for advanced
users.

Complete
All program features will be installed. (Reguires most disk
space)

< Back [t = Cancel

7 Click an installation option:

* Typical: (Recommended) Installs the StorNext client software and
help files in the default location (C:\Program Files\StorNext).

* Custom: Lets you choose which components to install and specify
an installation location. When ready, click Next.

* Complete: Same as a typical installation.

The Ready to Install window appears (figure 27).

Figure 27 SNFS Setup: Ready %
to Install Ready to Install

The Setup Wizard is ready to begin the Typical installation

Click Install to begin the installation. If you want to review or change any of your
installation settings, dick Back. Click Cancel to exit the wizard.

< Back

Cancel
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8 Click Install to continue.

Wait while the setup wizard installs StorNext. When installation is
complete, the Finish window appears (figure 28).

Figure 28 SNFS Setup: Finish i StorNext File System Setup x|

Completing the StorNext File
System Setup Wizard

Click the Finish button to exit the Setup Wizard.

<Back | Fnmish Cancel

9 Click Finish to close the setup wizard.
10 On the StorNext Installation window, click Exit.
You are prompted to reboot the system.
11 Click Yes to reboot.

You can now configure StorNext File System. For more information, see
Chapter 4, “Configuring StorNext.”

Restoring a Previous If you saved a client configuration file (for example, when removing a

Client Configuration previous version of StorNext), you can import it after installing StorNext.
This configures StorNext using the same settings as the previous
installation.

1 If necessary, unzip the client software archive file you downloaded
from the MDC.

2 Open the unzipped folder and double-click the client software
installer file. This file is named SnfsSetup32.exe (32-bit systems) or
SnfsSetup64.exe (64-bit systems).

The StorNext Installation window appears (figure 29).
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Figure 29 StorNext Installation
Window: Configure StorNext

Figure 30 StorNext
Configuration Window
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Quantum.

g [m[ 3]

Reinstall StorNext
Updates StorMexd file system

Remove StorMext
A Removes StorMext file system

S

Configure StorNext
Corfigure StorMext.

3 Click Configure StorNext.

The StorNext Configuration window appears (figure 30).

Stormet Confguration £
Quantum.

Name Servers

Configure StorMext name servers

Label Disk Drives
Format Drives with StorNext Label,

Simple Server Configuration
Create a basic StorMext flle system.

Impor/Export Client Settings

Import/Export StorMext dient registry settings
fromfto a file.

Client Configuration

&P e

Configure drive mappings and other StorMext
dient options.

4 Click Import/Export Client Settings.

The Import/Export Client Configuration window appears (figure 31).
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Figure 31 Import/Export Client
Configuration Window
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|
Quantum.

~ Export

Export StorMext Client registry settings to a file.

Client configuration export file:

Browse. .. |
Export |

 Import

Import StorMext Client registry settings from a file.

Client configuration file to import:

Browse... |

Discard current configuration and replace it with the Import File or merge Import File
with current configuration?

¥ Merge with current configuration

£~ Replace current configuration

Import |

Under Import, click Browse. Locate the client configuration (*.reg) file
to import, and then click Open.

Client configuration files saved during removal of a previous version
of StorNext are located in one the following directories:

e C:\SNFS\config\
* C:\Program Files\StorNext\config\
Click an option for handling current configuration settings:

* Merge with current configuration: The imported configuration is
merged with the current configuration settings.

* Replace current configuration: The imported configuration
overwrites the current configuration settings.

Click Import, and then click Yes to confirm.

A message appears informing you the configuration settings were
successfully added to the registry.

Click OK, and then click Quit to close the Import/Export Client
Configuration window.
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o Configuring StorNext
m

This chapter describes how to configure StorNext after installation. To
configure StorNext, enter license information and create one or more file
systems. In addition, on metadata controllers (MDCs) running StorNext
Storage Manager, you can add storage devices and media, create storage
policies, and set up e-mail notifications. In addition, Linux or Windows
SAN clients can be configured as a distributed LAN client or a distributed
LAN server.

For system running Unix or Linux, use the web-based GUI (graphical
user interface) to access StorNext running on an MDC (see StorNext
GUI).

The first time you log on to StorNext, the Configuration Wizard appears.
The wizard guides you through the process of setting up StorNext (see
Configuration Wizard on page 62).

To configure a StorNext client as a distributed LAN client or server, edit
the distributed LAN configuration file (see Configuring a Distributed
LAN Client Server on page 67).

For systems running Windows, use the Windows-based configuration
utilities to set up server and client features (see Windows Configuration
Utilities on page 72).
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StorNext GUI

The StorNext GUI provides access to StorNext features and displays
system status information. Use the StorNext GUI to create and work with
file systems. In addition, on metadata controllers running Storage
Manager, you can use the StorNext GUI to configure storage devices and
media, and to set up storage policies.

Note: The StorNext GUI is available only for MDCs running on Unix
or Linux. For MDCs running on Windows, use the
configuration utilities to configure StorNext (see Windows
Configuration Utilities on page 72).

Accessing the StorNext To log on to the StorNext GUI, use a web browser running on the MDC,
GUlI or on any system that has network access to the MDC.

1 Point a web browser to the URL of the MDC.

The URL consists of the host name or IP address of the MDC
followed by the port number at which StorNext can be reached. (The
default port number is 81.) For example: http://servername:81

Use one of the following web browsers to access the MDC (make sure
pop-up blockers are turned off):

* Internet Explorer 6.0 or later (including 7.0)
* Mozilla Firefox 1.5 or later (including 2.0 or later)

2 When prompted, type the user name and password for the MDC, and
click OK. (The default value for both user name and password is
admin.)

The StorNext home page appears. The appearance of the home page
differs depending on if both Storage Manager and File System are
installed on the MDC, or if File System only is installed.

The StorNext home page for an MDC running File System and
Storage Manager is shown in figure 32. The StorNext home page for
an MDC running File System only is shown in figure 33.
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Figure 32 StorNext Home Quantum. ‘i .';; . StorNext Home Help
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Configuration Wizard

The first time you log onto the StorNext GUI, the Configuration Wizard
appears. The wizard guides you step-by-step through the process of
configuring StorNext.

The appearance of the wizard differs depending on if both Storage
Manager and File System are installed on the MDC, or if File System only
is installed.

The Configuration Wizard for an MDC running File System and Storage
Manager is shown in figure 34. The Configuration Wizard for an MDC
running File System only is shown in figure 35.

Figure 34 StorNext 43 Configuration Wizard (CW) - Microsoft Internet Explorer =10l x|
Configuration Wizard: Storage =
Configuration Wizard
Manager Quantum.
Use this wizard to configure your Storhext product.
+ You can return to a step by clicking on its name
+ You can always return to the CW from the Config menu on the
Home Page
: « The reset button will start the CW from the beginning
o Step 1: Enter License
o Step 2: Add Flle System
onfi : Step 3: Add Library
C'"m‘:'um“o" Step 4: Add Tape Drive
Wizard Step 5: Add Media
Step 6: Add Storage Disks
Step 7: Add Storage Policy
Step 8: E-Mail Nofification
& StorNext
™ Don't Show CW Again | Reset | | Next® | | Done |
L]
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Figure 35 StorNext
Configuration Wizard: File
System Only

Quantum.

Home Page

Configuration
Wizard

(€ StorNext

Configuration Wizard

; Configuration Wizard (CW) - Microsoft Internet Explorer
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Use this wizard to configure your StorNext product.

+ You can return to a step by clicking on its name
« You can always retumn to the CW from the Config menu on the

: + The reset button will start the CW from the beginning

Qs Step 1: Enter License
g Step 2: Add File System

[~ Don't Show CW Again

L

Reset

]

| Next b |

L

Done

]

Displaying the
Configuration Wizard

manually:

The Configuration Wizard appears each time you log on to StorNext until
all steps of the wizard are completed. You can also control the wizard

* To set the Configuration Wizard to not appear the next time you log

in, select the Don’t Show CW Again check box.

* To display the Configuration Wizard at any time, on the Config
menu, click Configuration Wizard.

Using the Configuration

complete each step.

* To go to the next step, click Next.

e To return to a previous step, click the step in the list.

* To start the wizard over from the beginning, click Reset.

¢ To exit the wizard, click Done.
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The following sections describe each step of the Configuration Wizard.
Each step consists of a separate wizard that guides you through a task. To
complete a task, follow the onscreen instructions. To see more detailed
instructions for completing a task, refer to the indicated section in the
StorNext User’s Guide.

Note: Using the Configuration Wizard to configure StorNext is
optional. All configuration tasks can be accessed at any time
using the StorNext main menu, as described in the following
sections.

Step 1: Enter License

The Enter License Wizard guides you through the steps of entering a
license string. A license string must be entered before you can configure
or use StorNext.

You can generate a temporary license that is valid for 30 days. To obtain a
permanent license, contact the Quantum Technical Assistance center at
licenses@quantum.com and provide the following information:

* The product serial number from the StorNext box or CD.
* The number of client machines connecting to the MDC.

e The StorNext Server ID number. (This number can be found on the
Enter License String window of the Enter License Wizard.)

To display the Enter License Wizard at any time, on the Config menu,
click Enter License. For more information about entering a license, see
Chapter 4, “Common StorNext Tasks,” in the StorNext User’s Guide.

Step 2: Add File System

The Add New File System Wizard guides you through the steps of
creating and configuring a new file system. The wizard also lets you
establish a mount point for the file system, specify disk block size, and
customize stripe groups.

A file system is a shared data pool that can be accessed by client systems
and applications. Each file system contains one or more stripe groups. (A
stripe group is a logical volume that consists of one or more disks.)
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To display the Add New File System Wizard at any time, on the Config
menu, click Add File System. For more information about adding file
systems, see Chapter 6, “Managing the File System,” in the StorNext
User’s Guide.

Step 3: Add Library

The Add Library wizard guides you through the steps of adding and
configuring a tape library or vault. The wizard lets you specify the type of
library (SCSI, ACSLS, DAS, or vault) and set the appropriate parameters
for that library type.

To display the Add Library Wizard at any time, on the Config menu, click
Add Library. For more information about adding libraries, see Chapter 7,
“Managing Libraries,” in the StorNext User’s Guide.

Step 4: Add Tape Drive

The Add Drive Wizard guides you through the steps of adding and
configuring tape drives. The wizard lets you associate hardware devices
with libraries and, if necessary, map them to slots.

To display the Add Drive Wizard at any time, on the Config menu, click
Add Tape Drive. For more information about adding tape drives, see
Chapter 8, “Managing Drives and Disks,” in the StorNext User’s Guide.

Step 5: Add Media

The Add Media Wizard guides you through the steps of adding media to
a configured library. The wizard lets you specify a media type and, for
vaults, specify media IDs. (Before adding media, make sure no tape
drives contain media.)

To display the Add Media Wizard at any time, on the Config menu, click
Add Media. For more information about adding media, see Chapter 9,
“Managing Media,” in the StorNext User’s Guide.
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Step 6: Add Storage Disks

The Add Storage Disk wizard guides you through the steps of adding
external storage disks to a managed system. The wizard lets you specify
which file systems to define as storage disks. Once defined, storage disks
can be used as a target media type when creating storage policies.

To display the Add Storage Disk Wizard at any time, on the Config menu,
click Add Storage Disk. For more information about adding storage disks,
see Chapter 10, “Managing Storage Disks,” in the StorNext User’s Guide.

Step 7: Add Storage Policy

The Add New Storage Policy Wizard guides you through the steps of
adding disk-to-disk policy classes to a managed system. Storage policies
allow data to be intelligently moved between disks (stripe groups)
without affecting the file name space.

To display the Add New Storage Policy Wizard at any time, on the Config
menu, click Add Storage Policy. For more information about adding
storage policies, see Chapter 11, “Data Migration Management,” in the
StorNext User’s Guide.

Step 8: E-Mail Notification

The E-mail Notification Wizard guides you through the steps of setting
up e-mail notifications on the MDC. The wizard lets you specify the
SMTP server to use for outgoing e-mail, and the addresses to which
system alerts and notifications are sent. (Make sure the SMTP server is
configured before setting up e-mail notifications.)

To display the E-mail Notification Wizard at any time, on the Config
menu, click E-Mail Notification. For more information about setting up
e-mail notifications disks, see Chapter 4 “Common StorNext Tasks,” in
the StorNext User’s Guide.
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Configuring a Distributed LAN Client Server

Traditional StorNext SAN clients access data disks using a high
throughput, low-latency fibre channel connection. In addition, using the
distributed LAN client and server feature, StorNext clients can access
data disks over a network instead of directly accessing disks.

A StorNext client running on Linux or Windows can be configured as a
distributed LAN client or a distributed LAN server. (This is a licensed
feature.)

e Distributed LAN Server: A distributed LAN server has direct access to
data disks (using fibre channel) and makes the shared storage pool
available to distributed LAN clients over a network.

* Distributed LAN Client: A distributed LAN client does not have direct
access to data disks and instead accesses the shared storage pool by
connecting to a distributed LAN server over a network. (Distributed
LAN clients have full StorNext client functionality.)

Note: A StorNext client configured as a distributed LAN server
requires a dedicated system. Do not run other applications or
services on a system configured as a distributed LAN server.

To configure a Linux client as a distributed LAN client, see Configuring a
Distributed LAN Client on Linux. To configure a Linux client as a
distributed LAN server, see Configuring a Distributed LAN Server on
Linux.

To configure a Windows client as a distributed LAN server or a
distributed LAN client, use the Windows Client Configuration utility. For
more information, see Client Configuration on page 73 and Distributed
LAN on page 81.
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Configuring a Distributed To configure a StorNext client as a distributed LAN client, edit mount
LAN Client on Linux options in the /etc/fstab file.

1 Stop the StorNext client. At the command prompt, type:
/etc/init.d/cvfs stop

2 Configure the client to mount a file system as a distributed LAN
client. To do this, edit the /etc/fstab file so that it contains the
following line:

<file system> <mount point> cvfs rw,diskproxy=client 0 0

where <file system> is the name of the StorNext file system and <mount
point> is the directory path where the file system is mounted.

3 Start the StorNext client. At the command prompt, type:

[etc/init.d/cvfs start

Configuring a Distributed To configure a StorNext client as a distributed LAN server, edit mount
LAN Server on Linux options in the /etc/fstab file, and then configure distributed LAN server
options.

1 Stop the StorNext client. At the command prompt, type:
/etc/init.d/cvfs stop

2 Configure the client to mount a file system as a distributed LAN
server. To do this, edit the /etc/fstab file so that it contains the
following line:

<file system> <mount point> cvfs rw,diskproxy=server 0 0

where <file system> is the name of the StorNext file system and <mount
point> is the directory path where the file system is mounted.

3 Change to the fusr/cvfs/bin/ directory.

4 Launch the StorNext distributed LAN server configuration utility. At
the command prompt, type:

Isndpscfg -e

Note: To get help for the sndpscfg utility, at the command
prompt, type: ./sndpscfig -h

The distributed LAN server configuration utility appears (figure 36).
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Configuration Utility
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# Disk Proxy Server Configuration

# Un-comment and modify any of the following lines to override the default
# wvalues for tunable parameters.

#tcp_window_size_kb 64

#transfer_buffer_size_kb 256

#transfer_buffer_count 16

#server_buffer_count 8

#daemon_threads 8

#
# Interface Configuration
#

# One or more interfaces must be configured for Disk Proxy Server I/0.

# Un-comment one (and only one) of the 2 lines below to allow Disk Proxy
# Server I/0 on interface 'eth0' and to select the address to listen for
# connections on.

#interface ethO

interface eth0 address fec0::215:f2ff:fe6B8:afa2

5 Edit the default distributed LAN server configuration:

* (Required) Uncomment (delete the # next to) the line that
corresponds to the network interface used by the distributed LAN
server when connecting to distributed LAN clients. (For best
performance, do not choose the network used for metadata.)

(Optional) To change a tunable parameter from the default value,
uncomment the parameter, and then specify a new value. Table 12
describes the tunable parameters.

Note: The distributed LAN server configuration utility uses the
default text editor. If a default text editor has not been
specified, the utility uses the vi editor.
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Table 12 Distributed LAN

Server Parameters Field / Button

Description

tcp_window_size_kb

The TCP window size (in KB) used by the
distributed LAN server. (Default: 64)

transfer_buffer_size kb

The transfer buffer size (in KB) used by the
distributed LAN server. A larger buffer may
increase performance for larger files.
(Default: 256)

transfer_buffer_count

The number of transfer buffers used by the
distributed LAN server. This parameter is
used only by Windows servers and clients.
Linux servers pass the value of this
parameter to Windows clients. (Default: 16)

server_buffer_count

The number of 1/O buffers allocated for
each network interface on the distributed
LAN server. This parameter is used only by
Linux servers. (Default: 8)

daemon_threads

The maximum number of daemon threads
used by the distributed LAN server.
(Default: 8)

6 When you are done making edits, type :x to save and close the

configuration file.

The configuration is saved in the file dpserver in the /user/cvfs/config/

directory.

Note: To edit this file at a later date, you can run the sndpscfg
utility again or edit the dpserver file directly.

7 Start the StorNext client. At the command prompt, type:

/etc/init.d/cvfs start
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Creating an Override Configuration

By default, the settings specified in the dpserver configuration file are
used for all file systems mounted by the distributed LAN server. To use
different settings for a file system, create an override configuration file for
that file system. At the command prompt, type:

JIsndpscfg -E <file system>

where <file system> is the name of the file system to which the override
settings apply. Edit the configuration file, and then save and exit. A new
configuration file with the name dpserver.<file system> is created in the
luser/cvfs/config/ directory.

Using Distributed LAN Client and Server Commands
Use the cvadmin commands described in Table 13 to see information

about distributed LAN servers and clients. (For more information about
using cvadmin commands, see the CLI Reference Guide.)

Table 13 Distributed LAN
Client and Server Commands

StorNext 3.1.3 Installation Guide

Command Description

proxy Lists all distributed LAN servers for the
currently selected file system.

proxy long Lists all distributed LAN servers for the
currently selected file system, as well as
tunable parameters and attached disks.

proxy who <distributed LAN | Lists distributed LAN servers connected
client> to the specified distributed LAN client, as
well as current I/O statistics.

proxy who <distributed LAN | Lists distributed LAN clients connected to
server> the specified distributed LAN server, as
well as current I/O statistics.
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Windows Configuration Utilities

To configure StorNext File System or the StorNext client software on
Windows operating systems, use the Windows configuration utilities.
The configuration utilities let you set up a Windows-based metadata
controller, configure a StorNext client, and work with StorNext file
systems.

To run a configuration utility, on the Windows Start menu, click All
Programs > StorNext File System, and then click the utility.

The StorNext client software includes the following configuration
utilities:

Client Configuration on page 73

Disk Device Labeler on page 83

License Identifier on page 86

Simple File System Configuration on page 86

Start File System Services on page 88

Stop and Remove File System Services on page 88

Stop File System Services on page 88

Version Information on page 88

StorNext File System server includes all the configuration utilities
installed by the client software as well as the following additional
utilities:

StorNext 3.1.3 Installation Guide

Check (Read-Only) a File System on page 89

File System Startup List on page 89

Re-initialize a File System on page 91
Repair a File System on page 91

Server Administration on page 91

Server Configuration on page 97
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The Client Configuration utility lets you view and modify properties for
the StorNext client software. Use the utility to add name servers, map file
systems to drives, and configure a distributed LAN server or a
distributed LAN client.

To run the Client Configuration utility, on the Windows Start menu, click
All Programs > StorNext File System > Client Configuration.

The Client Configuration utility includes six tabs:

* Drive Mappings on page 73

* IS Name Servers on page 75

* Authentication on page 76

* Mount Options on page 78
* Syslog Level on page 79

* Cache Parameters on page 80

* Distributed LAN on page 81

Click a tab to view or modify StorNext client properties. After making
changes on one or more tabs, click OK to save the changes. A message
appears prompting you to restart the system. Click Yes. Most changes do
not take affect until the system is restarted.

Drive Mappings
To access a StorNext file system, it must be mapped to a local drive letter
on the client system.

Use the Drive Mappings tab (figure 37) to map file systems to local drives.
Table 14 describes the fields on the Drive Mappings tab.

Note: You must specify a file system name server on the FS Name
Servers tab before mapping drives.
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Note: You must disable the Windows Recycle Bin for each local
drive that is mapped to a file system. Right click the Recycle
Bin icon and click Properties. On the Global tab, click Configure
Drives Independently. On the appropriate Local Disk tab, select
the Do not move files to the Recycle Bin check box, and then

click OK.
Figure 37 Client Configuration: 2]
DriVe Mappings Drive Mappings | FS Name Servers I Authertication I Mourt Options I Syslog Level I Cache Parameters I Distributed LAN I
—Map Diive
Drrivve: IF' hd

File System: Isnfs‘l b

— Select Drive

Selected drive will be used for configuration in ather tabs.

Dirive: F: [srfs1] v

— Unmap Drive
|F: [snfsl]
Unmap

¥ Display File System Critical Events to Desk Top

™ Disable SNFS ONC Portmapper Process

[™ Don't Register with ONC Portmapper (port 111]

0K Cancel Help
Table 14 Client Configuration: . L
Drive Mappings Field / Button Description
Map Drive - Drive Select a local drive letter to associate with a
file system.
Map Drive - File Type or select the name of the file system to
System associate with the selected local drive letter.
Map Drive - Map Click to associate the selected local drive letter
with the selected file system.
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Field / Button Description

Select Drive - Drive Select the mapped drive to configure on the
other tabs of the Client Configuration utility.

Unmap Drive Select a drive to unmap.

Unmap Click to unmap the selected drive.

Display File System Select to display a notification dialog box if a

Critical Events to critical event occurs.
Desk Top .
(Because the dialog box must be manually

dismissed, clear this check box for unattended
client systems.)

Disable SNFS ONC Select to disable the SNFS portmapper service.

Portmapper Process . . . .
(Disable this service only if a product that

provides equivalent functionality is installed,
for example, the portmapper installed with
Microsoft Services for Unix).

Don’t Register with Select to not register with the SNFS
ONC Portmapper (port | portmapper service.
111)

FS Name Servers

To access a file system, you must first specify the name server (StorNext
host) where the file system is located. The first host in the list is the
primary name server. Additional hosts are backups for use in the event of
a failover.

Use the FS Name Servers tab (figure 38) to specify the primary StorNext
host. Table 15 describes the fields on the FS Name Servers tab.

Note: Make sure the host list is the same for all clients on the SAN.
An incorrect or incomplete host list may prevent the client
from connecting to the file system.
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FS Name Servers Drive Mappings  F5 Name Servers I.N.rthermcaﬁon I Mount Options I Syslog Level I Cache Parameters I Distributed LAN I
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Add

Eemove

ave Up

L

Mave Down

0K Cancel Help

Table 15 Client Configuration:

FS Name Servers Field / Button

Description

Add

Click to add the name server entered in the
box.

Remove

Click to remove the name server selected in
the list.

Move Up

Click to move the selected name server up in
the list.

Move Down

Click to move the selected name server down
in the list.

Authentication

If a Windows client accesses file systems that are also accessed by non-
Windows clients, you must specify an authentication method: Active
Directory, PCNFSD, or NIS. This method is used to map the Windows

StorNext 3.1.3 Installation Guide
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user to a user ID and group on the SAN. (Changes are applied when you
click Apply. You do not need to restart the client system.)

Use the Authentication tab (figure 39) to specify an authentication
method. Table 16 describes the fields on the Authentication tab.

Note: If your StorNext installation is Windows-only and you do not
plan to add non-Windows clients, you do not need to specify
an authentication method.

Figure 39 Client Configuration: & storMext File System Client Properties 20 x|
Authentication Drive Mappings I FS Name Servers Authentication | Mount Options I Syslog Level I Cache Parameters I Distributed LAN I
‘wiindows User
Aclive Directary
ADICHIzh, -
ADIC\hj;boasg\ J ’7 % Use Active Directaory ‘
ADIChmabt
ADICkmacalusf —HMIS Mame Servic
ADICAAD )
ADICYmagana] User Name: I
ADIChmagliors _
ADIC\MAIL0Zchtest IFERED
ADICYmaintenance i« Sarver I
ADIC\MAKD.PRF20
ADICYMAleRand CMIE
ADIC\MAlvarez
ADIC\MAnderta i« Server: I—
ADIC manickam X
ADICHM anit Diomain Marne: I
DI Chmanthony

ADICYmantanaccio  File Creation Permissions

ADICmanuf

ADICymarcomm R W
ADICMM arliana User | &
ADICMArmata I
ADIC marriottresidence201 Group [ &
ADIChmarriottresidence208

ADIC\mariottresidence21 7 Everpone 7 7

ADIChmarriotresidence223
ADIC\marriottresidence224

ADICymarriotresidence231 Apph
ADICHMartind, =l i |

‘WARNIMNG: sctive Directory will be the only mapping method supported in a future release.

This dialog will be depreciated

0K I Cancel Help

Table 16 Client Configuration: . L
Authentication Field / Button Description
Windows User Select the Windows user to map to a user ID
and group on the SAN.
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Field / Button

Description

Use Active Directory

Click to use LDAP to obtain the Active
Directory/Services for UNIX (SFU) mapping
for the selected user. (The client system must
be part of an Active Directory domain.)

User Name Type the user name that should be sent to the
authentication server. (PCNFSD and NIS
methods only.)

PCNFSD Click to use a PCNFSD server for

authentication.

PCNFSD - Server

Type the IP address of the PCNFSD server.

NIS

Click to use an NIS server for authentication.

NIS - Server

Type the name of the NIS server.

NIS - Domain Name

Type the domain name of the NIS server.

File Creation
Permissions

Select the default UNIX permissions for new
files created by the selected user. (PCNFSD
and NIS methods only.)

Apply

Click to Apply changes. (You do not need to
restart the client system.)

Mount Options

The Mount Options tab (figure 40) displays the mount options for the
drive currently selected on the Drive Mappings tab.

Caution:

Changing the values on the Mount Options tab can affect
system performance and stability. Do not change mount
options unless instructed to do so by the Quantum
Technical Assistance Center.
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Flgure 40 _(:Ilent Conflguratlon' Mount Paint ] Distributed LAN ~ Advanced Mount Options ] Advanced Cache Options
Mount Options
Maunt Cantral Timeouts
M ount B etransrmit Lirnit B0 Message Timeout » 1/10th Sec.
R, 12 Message Rety Count
™ Allow Diskless Mount 5 Rty 1/0's Forever
I ReadOrly
3 3  Allow 140 Timeouts
I~ Restrict Pre-allocation AP
1/0 Retw Time Seconds
300 140 Penaly Time Seconds
™ Fast Failover Detection
Threads
[ Hard Reconnect
8 Mumber of Async 140 Thieads
’—12 Murnber of System Threads Hualiyet Sevce (103)
B0 Token Hold Seconds
oK Cancel | Apply Help
Note: Selecting the Read Only check box has no effect. This feature
has been disabled.
Syslog Level
The system log level determines the types of messages the file system
records in the system event log.
Use the Syslog Level tab (figure 41) to specify the system log level. The
None level setting provides the least amount of logging and the Debug
level provides the most. The default level is Info.
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Figure 41 Client Configuration: 21
SyS|Og LeVeI Drive Mappings I FS Name Servers I Authentication I Mount Options ~ Syslog Level ICache Parameters I Distributed LAN I
Syslog Options for F: [snfs1)
" None

" Wiam

 Notice

& dnfe

" Debug

0K I Cancel Help

Cache Parameters

The Cache Parameters tab (figure 42) displays performance values that
control how many file system lookup names are kept in memory.

Caution:  Changing the values on the Cache Parameters tab can

affect system performance and stability. Do not change
cache parameters unless instructed to do so by the
Quantum Technical Assistance Center.
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Figure 42 Client Configuration: 2]
CaChe Parameters Drive Mappings I FS Name Servers I Authentication I Mount Options I Syslog Level Cache Parameters | Distibuted LAN I

Cache Options for F: [znfs1]

Meta-data Cache Low \w/ ater tark I Default - Entiies Buffer Cache Daemons Default Threads
Meta-data Cache High Water Mark, I Defaul | £ppias Buffer Cache Read Ahead Default Buffers

Meta-data Cache Max Water Mark I Defaul | ries  Buffer Cache Auta DMA Read Len Defaull Bytes
Meta-data Cache Puige Period I Default Seconds  Buffer Cache Auto DMA White Len Default Bptes

Data Buffer Size I Default g

Buffer Cache Cap. Shared by drives I 37 MEB
with the same Data Buffer Size Attribute Flush Time, non shared Default Seconds
1

i i D efault
Directory Cache Size, Shared by all l— “E Attribute Flugh Time, shared Seconds

drives.

0K I Cancel Help

Distributed LAN

A StorNext client running on Windows can be configured as a distributed
LAN client or a distributed LAN server. (This is a licensed feature.)

¢ Distributed LAN Server: A distributed LAN server has direct access to
data disks (using fibre channel) and makes the shared storage pool
available to distributed LAN clients over a network.

* Distributed LAN Client: A distributed LAN client does not have direct
access to data disks and instead accesses the shared storage pool by
connecting to a distributed LAN server over a network. (Distributed
LAN clients have full StorNext client functionality.)

Note: A StorNext client configured as a distributed LAN server
requires a dedicated system. Do not run other applications or
services on a system configured as a distributed LAN server.
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Use the Distributed LAN tab (figure 43) to configure a distributed LAN
server or a distributed LAN client. Table 17 describes the fields on the

Distributed LAN tab.

Figure 43 Client Configuration:
Distributed LAN

Distributed LAM Options for F: [snfsl]

I” Enable Client
V¥ Enable Server

&% Storllext File System Client Properties 21

Drive Mappings | FS Name Servers | Authentication | Mount Options | Syslog Level | Cache Parameters  Distributed LAN I

r— Server Options

Mumber of Transfer Buffers I 16 TCP Window Size [kb] 64
Tranzlter Buffer Size (kb] I 286 Max Daemon Thieads 8

- Server Interfaces

Select server interface(s) to use. Only one address per MIC is allowed.

Addiess | Desciiption
o DD-’ Local Area Connection - Broadcom 570% Gigabit Integrated Contral
=] 1PV 4 Address
4 | |
ok | cacel | Hep |
Table 17 Client Configuration: . A
Field / Button Description

Distributed LAN

Enable Client

Select to configure the StorNext client as a
distributed LAN client. The StorNext client
will connect to all available distributed LAN
servers.

(If you select this check box, all other fields on
the tab become unavailable.)

Enable Server

Select to configure the StorNext client as a
distributed LAN server. The StorNext client
will make the disks for this file system
available to distributed LAN clients over the
specified LAN.
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Field / Button Description
Number of Transfer Type the number of transfer buffers used by
Buffers the distributed LAN server. (Default: 16)

Transfer Buffer Size Type the transfer buffer size (in KB) used by
(kb) the distributed LAN server. A larger buffer
may increase performance for larger files.
(Default: 256)

TCP Window Size (kb) | Type the TCP window size (in KB) used by
the distributed LAN server. (Default: 64)

Max Daemon Threads | Type the maximum number of daemon
threads used by the distributed LAN server.
(Default: 8)

Disk Device Labeler

StorNext 3.1.3 Installation Guide

Server Interfaces Select the server interface (network interface
card) to use when connecting to distributed
LAN clients. If a network interface has more
than one address configured, you must select
one of the addresses to use for distributed
LAN connections. (For best performance, do
not choose the network used for metadata.)

The Disk Device Labeler utility lets you configure StorNext File System
storage area network (SAN) disks. Use the Disk Device Labeler to create a
list of disk labels, associated device names, and (optional) the sectors to
use.

Note: Run the Disk Device Labeler on a system that has visibility to
all disk devices on the SAN.

The file system uses the volume labels to determine which disk drives to
use. The label name written to a disk device must match the disk name
specified in the Server Configuration utility. For more information, see
Server Configuration on page 97.
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Caution:  Modifying the label of a system disk may render the
system inoperable and require you to repair the volume.
Only label disk devices that are intended for use with the
StorNext File System SAN.

To run the Disk Device Labeler utility, on the Windows Start menu, click
All Programs > StorNext File System > Disk Device Labeler. The Disk
Labeler window (figure 44) appears.

F|gu|"e 44 Disk Device Labeler StorNest File System Disk Labeler _ ol x|

Device Name Yolume Type  Drive Letter  Disk Label SectorSize  Physical Sectors Configured Sectors

PhysicalDrivel Windows E.C: 512 35558380 ;I
Phpsicallrivel CVFS metiz001 512 142129152 142129182
Phusicallrive2 metiz002 2 142129152 142129152
PhysicalDrived metiz003 512 142129152 142129152
Phpsicalbrived metiz]04 512 142129152 142123152
PhysicalDrived metiz105 512 142129152 142123152
PhysicalDrivet metis006 512 142129152 142129152
PhysicalDrive? metis007 512 142129152 142129182
Phpsicalbrived metiz)08 512 142129152 142123152
Phusicallrived metiz009 m2 142129152 142129152
PhysicalDrivel0 mothrsl 512 £39570752 £39570752
Phpsicallrivell miothraZ 512 E38670752 E35570752
Phsicalbrivel2 mothra3 512 E38670752 E35570752
PhysicalDrivel3 mothrad 512 E39570752 B39570752
Physicallrivel4 mothraf 512 E35570752 E35570752
5 & mathiaE: 2 52 E 4

H

Clear Selections | Select which disk drives to label
Label I UnLabel I Exit Probe Disk(s] Help

On the Disk Labeler window, do one of the following:

* Click Label to write a volume label to the selected device(s) (see
Labeling Disks below).

* C(lick UnLabel to remove the existing volume label from the selected
device(s).

* Click Exit to quit the Disk Device Labeler utility.

* Click Probe Disk(s) to pulse the activity light of the selected device(s).
Use this feature to correctly identify disks before labeling them.

¢ (lick Clear Selections to deselect all devices in the list.
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Labeling Disks

When you select one or more disks and click Label, a confirmation screen
appears asking if you are sure you want to proceed. Click OK to continue.
The Disk Labeler dialog box appears (figure 45). Table 18 describes the
fields on the on the Disk Labeler dialog box.

StorMext File System Disk Labeler x|

Device Mame Phsicallrivel5

Diisk Label Imathrab
Disk Size i Sectors (539570752

Configured Sectars  [639570752

Mew Disk Label

Mew Sectars |5395TD?52

Create Label I Skip Disk Cancel

Table 18 Disk Labeler Dialog
Box

StorNext 3.1.3 Installation Guide

Field / Button Description

New Disk Label Type the label for the disk.

New Sectors (Optional) Type the number of sectors on the
disk.

Create Label Write the new label to the disk and proceed to

the next selected disk.

Skip Disk Do not write a label to the disk and proceed to
the next selected disk.

Cancel Close the Disk Labeler dialog box.
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Use the License Identifier utility to display the host license identifier. The
host license identifier is required to obtain a permanent license for
StorNext.

To run the License Identifier utility, on the Windows Start menu, click All
Programs > StorNext File System > License Identifier. A dialog box
displays the host license identifier. Record this information.

To obtain a license, use the Configuration Wizard. For more information,
see Using the Configuration Wizard on page 63. Alternately, you can
manually copy a license file to the StorNext Configuration directory.

To obtain a permanent license, contact the Quantum Technical Assistance
center at licenses@quantum.com and provide the following information:

* The product serial number from the StorNext box or CD.
* The number of client machines connecting to the MDC.
* The host license identifier you recorded.

A Quantum support representative will send you a license.dat file. Copy
the file to the C:\Program Files\StorNext\config directory. (If there is a
temporary license file, overwrite the file.)

The Simple File System Configuration utility can be used instead of the
Server Configuration utility to configure a basic StorNext file system with
a single stripe group.

Note: Before configuring a file system, you should label disk devices.
For more information, see Disk Device Labeler on page 83.

To run the Simple File System Configuration utility, on the Windows
Start menu, click All Programs > StorNext File System > Simple File System
Configuration. The Simple Configuration Setup window appears

(figure 46). Table 19 describes the fields on the Simple Configuration Setup
window.

To configure a simple file system, select the disks to use in the
configuration. Specify settings (file system name, block size, stripe size,
and maximum connections), and then click Configure.
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Figure 46 Simple File System

Configuration
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Storllext File System Simple Configuration Setup

=10 =]

Device Mame Volume Type  Drive Letter  Disk Label Sector Size Physical Sectors Configured Sectars
Physicallnvell urkrown 512 390719837 -
PhysicalDrivel CWFS sucubus2 512 1391568184 139158184

FhysicalDrive2 CWFS
PhysicalDrived CWFS
PhysicalDrived CWFS
PhysicalDrive5 CWFS
PhysicalDriveb CWFS
PhyszicalDrive? RS
Physicallrived CWFS
Physicallrived CWFS
Physicallnivell CWFS

sucubus04
sucubuslb
sucubus0d
sucubus10
sucubus0l
sucubus03
sucubus0s
sucubus0?
sucubus03

139158184
130158184
139156184
139156184
139156184
130168184
139158184
139156184
139158184

133158184
129158184
129158184
139156184
139156184
129168184
139158184
139168184

139158184 LI

File: System Mame

Select Al | Select which disk diives to use in the canfiguration

File Spstem Black Size

Stripe Size in Blocks M gimurn Connections

[getau ek =] [ =l 32
Configure | Eit I Help |
Table 19 Simple File System . L
P y Field / Button Description
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Clear Selections

Click to deselect all devices in the list.

Select All

Click to select all devices in the list.

File System Name

Type the name of the file system. This is the
name used by clients when establishing a
mount point for the file system.

File System Block
Size

Select the file system block size (in bytes). This
is the minimum allocation size used by the file
system.

Stripe Size in Blocks

Select the stripe size (in blocks). This is the
number of file system blocks to write before
switching to the next disk in the stripe group.

Maximum
Connections

Type the maximum number of clients that can
simultaneously mount the file system. (This
value may be overridden by values in your
product license code.)

Configure Click to save the configuration using the
current settings. The configuration file is
saved in the StorNext configuration directory.

Exit Click to quit the Simple File System

Configuration utility.
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The Start File System Services utility starts all StorNext services on an
MDC or StorNext client.

The StorNext services must be running on the MDC for file systems to be
active and available. In addition, the StorNext services must be running
to use the StorNext configuration utilities and to mount file systems using
the client software.

To start StorNext File System services, on the Windows Start menu, click
All Programs > StorNext File System > Start File System Services.

The Stop and Remove File System Services utility stops all StorNext
services on an MDC or StorNext client, and also removes registry entries
that automatically start the services on bootup.

To stop and remove StorNext File System services, on the Windows Start
menu, click All Programs > StorNext File System > Stop and Remove File
System Services.

To start the StorNext services again, you must use the Start File System
Services utility. Rebooting the system will not restart services. For more
information, see Start File System Services.

The Stop File System Services utility stops all StorNext services on an
MDC or StorNext client.

To stop StorNext File System services, on the Windows Start menu, click
All Programs > StorNext File System > Stop System Services.

To start the StorNext services again, reboot the system or use the Start File
System Services utility. For more information, see Start File System
Services.

The Version Information utility displays information about the currently
installed version of the StorNext server and/ or client software, such as
the version number, build number, and platform.

To run the Version Information utility, on the Windows Start menu, click
All Programs > StorNext File System > Version Information. A dialog box
displays version information for the StorNext server and/or client
software installed on your system.
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The Check (Read-Only) a File System utility allows you to check a
StorNext file system for metadata corruption (due to a system crash, bad
disk, or other failure). Run the utility on an MDC that contains the file
system you want to check.

To check a file system, on the Windows Start menu, click All Programs >
StorNext File System > Check (Read-Only) a File System. Type the number
that corresponds to the file system you want to check, and then press
<Enter>.

Because the file system check is run in read-only mode, any problems that
exist are not repaired. If the utility identifies errors or corruption in
metadata, you must repair the file system (see Repair a File System on
page 91).

The File System Startup List utility lets you modify the File System
Manager (FSM) services list and set file system priority.

The File System Manager is a process that manages the name space,
allocations, and metadata coherency for a file system. Each file system
uses its own FSM process. When there are multiple file systems (and
therefore multiple FSM processes), the FSM services list controls which
FSM processes are run when the server starts up, and also sets the
priority for each file system (for failover configurations).

To run the File System Startup List utility, on the Windows Start menu,
click All Programs > StorNext File System > File System Startup List. The
FSM Services List window appears (figure 47). Table 20 describes the
fields on the FSM Services List window.
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Figure 47 File System Startup B
List
File Systern Mames
m Hast Mame [optional]
kazar
Priarity
il -
Mew .. Delete
akK | Cancel I Help
Table 20 File System Startu . -
List y P Field / Button Description

New Click to add a file system to the FSM services
list. Type the name of the file system and click
OK.

Delete Click to remove the selected file system from
the FSM services list.

Host Name (Optional) Type the name of the host on
which the file system is running.

Priority (Optional) Select the priority for the selected
file system. This priority is used for failover
configurations. 0 is highest priority and 9 is
lowest priority.

OK Click to save changes to the FSM services list.

Cancel Click to quit the File System Startup List

utility without saving changes.
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The Re-initialize a File System utility allows you to initialize an existing
file system. Initializing a file system prepares it for use.

Caution: Re-initializing a file system will destroy all data on the file
system.

Repair a File System

Server Administration

StorNext 3.1.3 Installation Guide

To initialize a file system, on the Windows Start menu, click All Programs
> StorNext File System > Re-initialize a File System. Type the number that
corresponds to the file system you want to re-initialize, and then press
<Enter>.

The Repair a File System utility lets you repair corrupted metadata on a
file system. Repair a file system if errors were identified when checking
the file system (see Check (Read-Only) a File System on page 89).

The file system must be inactive in order to be repaired. To stop a file
system, use the Server Administration utility (see Server Administration).

To repair a file system, on the Windows Start menu, click All Programs >
StorNext File System > Repair a File System. Type the number that
corresponds to the file system you want to repair, and then press <Enter>.

The Server Administration utility lets you view and modify stripe group
properties and set quotas. A stripe group is a logical storage unit made
up of one or more disks. A quota is a space limit that is set for specified
users or groups.

To run the Server Administration utility, on the Windows Start menu,
click All Programs > StorNext File System > Server Administration. The
Administrator window appears (figure 48). The left pane shows file
systems running on the currently connected MDC. Expand a file system
to see stripe groups, quotas, and other properties.
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Il Storllext File System Administrator

File Wiew Help
=-{&) SNFS Service (on host kazar) || File System Name | stripe Groups | Total Blocks

=1oix|

I Free Blocks

=g, SNFS File Systems snfst 1 261844 (4.00 GB)

e R
H - Stripe Groups
- Quotas
@ qos
~-E Clients
: - Debug
=8, SNFS Disk Devices
o diskno1
L5 diskdn2

210595 (3.21 GB) (80%)

|connect=d to kazar

On the Administrator window, do one of the following:

* To connect to an MDC, click File > Connect to. Type the host name
and click OK. File systems on the server appear in the left pane.

* To start a file system, click it in the left pane. Click File > Start File

System, and then click Start.

* To activate a file system, click it in the left pane. Click File > Activate

File System, and then click Activate.

* To stop a file system, click it in the left pane. Click File > Stop File

System, and then click Stop.

* To update the list of file systems in the left pane, click View > Refresh.

For more information about viewing and modifying file system

properties and quotas, see the following sections:

* File System Properties on page 93

* Stripe Group Properties on page 94

* Quota Properties on page 95

* Quality of Service Information on page 97

* (lients Information on page 97

Note: Do not change settings on the Debug Settings dialog box
unless directed to do so by the Quantum Technical Assistance

Center.
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To view or change file system properties, click a file system in the left
pane, and then click the file system name in the right pane. The File
System Properties dialog box appears (figure 49). Table 21 describes the
fields on the File System Properties dialog box.

After making changes, click OK. (Not all fields can be modified on this

dialog box.)
Figure 49 Server
Administration: File System st |
Properties
Active Clients: 0 Dizk Devices: 1
f=g Buffer Size: 4K Stipe Groups: 1

Fs Block Size: 16K

[ File Spstem Quatas Global Superuzer
[ Distributed Locking Quality-of- Service

Windaws Security

21

Uzag:

]

Fs Blocks: 261844 (4.00 GB)
FsBlocks Free: 2105595 (3.21 GB)

20%

co|

Table 21 Server

Administration: File System Field / Button

Description

Properties Active Clients

The number of active clients on the file
system.

Msg Buffer Size

The size of the message buffer.

Fs Block Size

The file system block size.

Disk Devices

The number of disk devices in the file system.

Stripe Groups

The number of stripe groups in the file
system.

File System Quotas

Select to enable file system quotas.

StorNext 3.1.3 Installation Guide
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Field / Button Description

Distributed Locking Indicates if distributed locking is enabled or
disabled.

Windows Security Indicates if Windows security is enabled or
disabled.

Global Superuser Indicates if the global superuse is enabled or
disabled.

Quality-of-Service Indicates if Quality of Service is enabled or
disabled.

Usage Displays the amount of used and free storage
space in the file system.

Stripe Group Properties

To view or change stripe group properties, expand a file system in the left
pane, click Stripe Groups, and then click the stripe group name in the
right pane. The Stripe Group Properties dialog box appears (figure 50).
Table 22 describes the fields on the Stripe Group Properties dialog box.

After making changes, click OK. (Not all fields can be modified on this
dialog box.)

Properties |

5 tripeGroupi

Stripe Group Mame: Status
’7 @« Up  Down

Configuration

Stripe Breadth [blocks): 4
Stripe Depth (units]: 1

O Exclusive Multi-Path Method: Rotate
tetadata

Journal

O Realime

Usage: (] 2%

Total Blocks: 261844 [4.00 GB)
Free Blocks: 258595 [3.95 GB)

e
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Table 22 Server
Administration: Stripe Group
Properties

StorNext 3.1.3 Installation Guide

Download from Www.Somanuals.com. All Manuals Search And Download.

Field / Button

Description

Stripe Group Name

The name of the stripe group.

Status

Shows the current status of the stripe group.
Click Up to make the stripe group active or
click Down to make the strip group inactive.

Stripe Breadth

The number of file system blocks to write
before switching to the next disk in the stripe

group.

Stripe Depth

The number of disks in the stripe group.

Exclusive Indicates if only specified file types
(associated with the stripe group affinities)
can be stored on the stripe group.

Metadata Indicates if file system metadata can be stored
on the stripe group.

Journal Indicates if the file system logging journal can
be stored on the stripe group.

Realtime (no longer supported)

Multi-Path Method

Indicates the method the file system uses to
access the disk: round, static, or sticky.

Usage

Displays the amount of used and free storage
space in the stripe group.

Quota Properties

Quotas define the amount of storage space a specified user or group is
allowed to own. You can set hard or soft quota limits.

To view or change quota properties, expand a file system in the left pane,

and then click Quotas. The Quota Properties dialog box appears

(figure 51). There are two tabs:

* Set quotas for users on the User Quotas tab.

* Set quotas for groups on the Group Quotas tab.

95



Figure 51 Server
Administration: Quota
Properties

Chapter 4 Configuring StorNext
Windows Configuration Utilities

Table 23 describes the fields on the User Quotas and Group Quotas tabs.
After making changes, click OK. (Not all fields can be modified on this

dialog box.)

Quota Properties

User Quotas | Group Quotas |

-

C

"User Mame

In Use:

Usage: |

— Huata Setting:
Hard Limit I =
Soft Limit: I =
Timne Limit
o Hp =Hp =
Days Hours Minutes
Get Quota | Set Quota |

con |

Table 23 Server
Administration: Quota
Properties
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Field / Button

Description

User Name / Group
Name

Type the name of the user or group to set a
quota for.

Usage Displays the percentage of the quota that has
been used.

Hard Limit Specify an amount in B, KB, MB, GB, or TB, or
EB. This is the maximum amount of space the
specified user or group can use.

Soft Limit Specify an amount in B, KB, MB, GB, or TB, or

EB. Once the user or group uses this amount
of space, a warning is sent. (Typically this is
80% of the hard limit.)
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Field / Button Description

Server Configuration

StorNext 3.1.3 Installation Guide

Time Limit Specify the amount of time it takes for the soft
limit to turn into a hard limit.

Get Quota Click to get quota settings for the specified
user or group.

Set Quota Click to set a quota for the specified user or
group using the current settings.

Quality of Service Information

To view Quality of Service (QOS) information for a file system, expand a
file system in the left pane, and then click QOS. Quality of Service
information appears in the right pane, including stripe group, real-time
limit, non-real-time reserve, committed RTIO, and the number of non-
real-time clients.

Clients Information

To view information about clients connected to the file system, expand a
file system in the left pane, and then click Clients. Information about the
currently connected clients appears in the right pane, including client ID,
type, location, up time, and when the client license expires.

The Server Configuration utility lets you view and modify properties for
an MDC. Use this utility to create a new server configuration or modify
an existing configuration.

To run the Server Configuration utility, on the Windows Start menu, click
All Programs > StorNext File System > Server Configuration. The
Configuration Administrator window appears (figure 52).
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Figure 52 Configuration Storiext File System Configuration Administrator o]
Administrator

StorNext
File System

|
Modify Existing ... | Exit | About |

On the Configuration Administrator window, do one of the following:
* Click New to create a new configuration file.

* Click Modify to edit an existing configuration file. Browse for the
configuration (*.cfg) file and click Open.

* Click Exit to close the Configuration Administrator window.

When you create a new configuration file or open an existing
configuration file for editing, the StorNext File System Configuration
window appears. This window includes four tabs:

* Global Settings on page 99
* Disk Types on page 101
* Disk Definitions on page 103

* Stripe Groups on page 105

Click a tab to view or modify StorNext File System properties. After
making changes on one or more tabs, click OK to save the changes.
Specify a name and a location for the *.cfg file, and then click Save.

Note: Before configuring a file system, you should label disk devices.
For more information, see Disk Device Labeler on page 83.
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Use the Global Settings tab (figure 53) to specify general file system
properties. Table 24 describes the fields on the Global Settings tab.

Flgu re 53 Server StorMext File System Configuration: New File 2lx|
Configuration: Global Settings Global Setings | Disk Types | Disk Defintons | Stoe Groups |
File Size Dynamic E xpansion — Default Unix Mappings
[ Global Supenser [ IB Blocks "Hobody® UID I—BDDD'I
I~ Windows Security
I Quotas Increment |32 Blacks Mobody"GID IBUUD‘I
™ Cluster File Lacking i aximum |204E Blocks Default File Mode IDB44
Default Directon Mode ID?EE
File System Block Size |18384 'I Eytes
Bufter Cache Size |32 Megabytes I™" Use Fabricated IDs
Journal Log Size |1B Megabytes
Inode Cache Size |32?BB Entries
td awimum Debug Log Size |4 tegabytes
Thread Pool Size |1B Threads
Marimum Connections |32 Connections
Allocation Strateay [Roynd  »
Cancel Apply
Table 24 Server Configuration: . L
Field / Button Description

Global Settings

StorNext 3.1.3 Installation Guide

Global Superuser

(Optional) Select to allow a user with
superuser privileges to have global access
rights on the file system.

Windows Security

clients.

(Optional) Select to use Windows Security
Reference Monitor (ACLs) on Windows
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Field / Button

Description

Quotas

(Optional) Select to enforce file system quotas
and track storage usage for individual users
and groups.

Cluster File Locking

(Optional) Select to send a warning when a
user attempts to access a file that is locked or
already in use.

File Size Dynamic
Expansion - Minimum

Type the minimum number (in blocks) to
allocate when a file is created.

File Size Dynamic
Expansion - Increment

Type the initial increment (in blocks) by
which a file is expanded.

File Size Dynamic
Expansion - Maximum

Type the maximum increment (in blocks) by
which a file is expanded.

File System Block
Size

Select the file system block size (in bytes).

Buffer Cache Size

Type the amount of memory (in MB) used for
general metadata information caching.

Journal Log Size

Type the maximum size (in MB) for the
journal log.

Inode Cache Size

Type the number of entries in the inode cache.

Maximum Debug Log
Size

Type the maximum size (in MB) for the debug
log.

Thread Pool Size

Type the number of threads the FSS uses
when reading and storing files.

Maximum
Connections

Type the maximum number of simultaneous
connections (SNFS clients and Administrative
Tap clients) allowed by the FSS.

StorNext 3.1.3 Installation Guide
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Field / Button Description
Allocation Strategy Select the method of allocation for new disk
blocks:

* Round: Alternate between similar stripe
groups. (Default)

* Fill: Fill the first stripe group before using
the second.

* Balance: Use the stripe group with the most
free space.

“Nobody” UID Type the Windows user ID to use when no
user ID can be found using Active Directory.

“Nobody” GID Type the Windows group ID to use when no
group ID can be found using Active
Directory.

Default File Mode Type the permission mode to use when
creating files.

Default Directory Type the permission mode to use when
Mode creating directories.
Use Fabricated IDs Select if the metadata controller is running on
Apple MacOS X.
Disk Types
Use the Disk Types tab (figure 54) to define disk types used in the file
system.
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Figure 54 Server 21
Conﬁguration: DISk Types Global Settings Disk Types | Disk Definitions | Stripe Groups I

Disk Types Defined
Specifications

Nurber of Sectors

Sector Size

Edt | Dekete |

ok | cancsl Spply

On the Disk Types tab, do one of the following:
* To add a new disk type, click New.
* To modify a disk type, select the disk type in the list and click Edit.
* To delete a disk type, select it in the list and click Delete.

When you add or modify a disk type, the Enter New Disk Type dialog box
appears (figure 55). Table 25 describes the fields on the Enter New Disk
Type dialog box.

Note: The Sector and Sector Size fields are populated with values
from the Disk Device Labeler utility. For more information, see
Disk Device Labeler on page 83.
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Figure 55 Server x
Configuration: Enter New Disk

Dizk Type
Type

Sectors

Sector Size

[

Cancel |

Table 25 Server Configuration: . -
Enter New Disk Type Field / Button Description
Disk Type Type a descriptive name for the disk.
Sectors Type the number of physical sectors on the
disk.
Sector Size Type the size of sectors on the disk.
OK Click to create the new disk type with the
specified properties.
Cancel Click to close the Enter New Disk Type dialog
box without saving changes.

Disk Definitions

Use the Disk Definitions tab (figure 56) to create disk definitions and
modify disk specifications. Table 26 describes the fields on the Disk
Definitions tab.
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I~ Statuz Up

Disk. Type
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New.. | Delete |
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E?:&egeiiniﬁ;::r Configuration: Field / Button Description

StorNext 3.1.3 Installation Guide

Disks Available - New

Click to create a new disk definition. Type a
name for the disk and click OK.

Disks Available -

Click to delete the selected disk definition.

Delete

Status: Up Select to enable the selected disk definition.
When enabled, the defined disk is available to
the configured file system for I/O.

Disk Type Select a disk type for the selected disk

definition. (Disk types are defined on the Disk
Types tab.)

Device Names - New

Click to add a device name to the disk
definition. Type a device name and click OK.
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Field / Button Description

Device Names - Delete | Click to delete the selected device name.

Stripe Groups

Use the Stripe Groups tab (figure 57) to define stripe groups. (A stripe
group is a logical storage unit consisting of one or more disk drives.)
Table 27 describes the fields on the Stripe Groups tab.

Figure 57 Server

Configuration: Stripe Groups

Storiext File System Configuration: New File ﬂzl

Global Settings I Disk Types I Disk Definitions ~ Stripe Groups |

— Specification:

Stipe Groups Available — Drive List
. — Flag:

™ Status: Up
™ Exclusive
" MetaData
™ Joumnal

Stripe Breadth [Blocks]

—_——

Affinities

New Delete

Pathing Method

Rotate VI Modify Drive List |

—QOS P,
Rtios RliczReserve RiTokenTimeout Rtmb RitmbR eserve

Mew | Delete I

oK | Cancel | mopy
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Table 27 Server Configuration:
Stripe Groups
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Field / Button

Description

Stripe Groups
Available - New

Click to create a new stripe group. Type a
name for the stripe group and click OK.

Stripe Groups
Available - Delete

Click to delete the selected stripe group.

Status: Up

Select to enable the selected stripe group.
When enabled, the stripe group is available to
the configured file system for I/O.

Exclusive

Select to allow only file types associated with
the affinities specified under Affinities to be
stored on the stripe group.

MetaData

Select to allow file system metadata to be
stored on the stripe group.

Journal

Select to allow the file system logging journal
to be stored on the stripe group.

Affinities - New

Click to add a new affinity to the stripe group.
Type the name of the new affinity and click
OK. (Affinity names cannot be longer than
eight characters.)

Affinities - Delete

Click to the delete the selected affinity.

Pathing Method

Select a method for how the file system
accesses the disk:

* Rotate: Chooses an I/O path based on load.
* Static: Always uses the same I/O path.

¢ Sticky: Chooses an I/O path based on the
identity of the target file.

Rtios

Type the number of disk I/O operations per
second available to real-time applications
using the Quality of Service (QOS) APL

RtiosReserve

Type the minimum number of disk I/O
operations per second reserved for non-real-
time applications.
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Field / Button

Description

RtTokenTimeout

Type the number of seconds to wait for clients
to respond to a token callback.

Rtmb

Type the number of MBs per second available
to real-time applications using the Quality of
Service (QOS) APL

RtmbReserve

Type the minimum number of MBs per
second reserved for non-real-time
applications.

Modify Drive List

Click to add or remove disks for the selected
stripe group. Use the left and right arrows to
add or remove disks in the Primary Disks list,
and then click OK.

Caution:  When adding a disk to an existing stripe group, make sure
the disk is added to the bottom of the Drive List. If the disk
is inserted in the middle of the list, the file system behaves
as if files on the file system are corrupted.

StorNext 3.1.3 Installation Guide
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Appendix A

o Uninstalling StorNext
m

If you no longer need to use StorNext, uninstall the software to remove it
from your system. To uninstall StorNext, use the appropriate method for
your operating system:

* Uninstalling StorNext on Unix and Linux on page 108
* Uninstalling StorNext on Windows on page 111

Uninstalling StorNext on Unix and Linux

To uninstall StorNext on a metadata controller (MDC), use the
installation script (see Uninstalling SNSM and SNFS on page 109).

To uninstall the StorNext client software, use the appropriate method for
your operating system (see Uninstalling the StorNext Client Software on
page 110).
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Uninstalling StorNext on Unix and Linux

Uninstalling SNSM and To uninstall StorNext File System and Storage Manager on an MDC
SNFS running Unix or Linux, run the installation script with the -remove option.
To launch the script, use the correct StorNext installation CD for your
operating system.

1 Log on to the MDC as root.

2 Mount the StorNext installation CD and change to the CD root
directory.

Note: When you mount a CD in a Red hat 4 or 5 system, CDs are
mounted by default with a noexec (non-executable) option
which prevents you from proceeding with the installation.

For Red Hat users only, before proceeding you must
remount the CD by typing mount -o remount, exec ...

3 List the installation directories on the CD. At the command prompt,
type:
Is -l

4 Identify the correct installation directory for your operating system
and hardware platform, and then change to that directory.

For example, for Red Hat Linux 4 running on an x86 64-bit platform,
change to the RedHat40AS_26x86_64 directory.

5 Do one of the following;:

* To uninstall StorNext Storage Manager and File System, at the
command prompt, type:

Jinstall.stornext -remove
* To uninstall StorNext File System, at the command prompt, type:
Jinstall.snfs -remove

The installation script runs (figure 58).
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Figure 58 StorNext Remove Stornext Remove 3.1.3 (5)  MAIN MENT
Main Menu 1) Installation Configuration
2) Remove STOINEXT

3) Show Status

4) Quit

Enter your choice <2»:

6 Type 2 and press <Enter>.

7 After the uninstall process is complete, type 4 and press <Enter> to
exit the installation script.

Uninstalling the StorNext To uninstall the StorNext client software, unmount all file systems and
Client Software stop StorNext software. Then remove the client software package using
the appropriate command for your operating system.

Note: This procedure removes the client software only. To uninstall
StorNext File System and Storage Manager, see Uninstalling
SNSM and SNES on page 109.

1 Unmount all file systems. To unmount a file system, at the command
prompt, type:
umount <mount point>
where <mount point> is the location where the file system is mounted.
2 Stop the StorNext client software. At the command prompt, type:
/etc/init.d/cvfs fullstop

3 Remove the StorNext software package using the correct commands
for your operating system.

¢ Linux:
rpm -e <package name>

where <package name> is the name of the client software package
that was installed.

e Solaris:
pkgrm ADICsnfs
¢ HP-UX:

StorNext 3.1.3 Installation Guide 110

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix A Uninstalling StorNext
Uninstalling StorNext on Windows

swremove —x mount_all_filesystems=false snfsclient
e IBM AIX:
installp —u <package name>

where <package name> is the name of the client software package
that was installed.

¢ SGIIRIX:
Inst
remove cv_base
remove cv_cint

go

Note: If you do not know the package name, you can download
the client software for your operating system and check
the package name (see Downloading the StorNext Client
Software on page 39).

Uninstalling StorNext on Windows

To uninstall StorNext (server or client) on a Windows system, use the
Add or Remove Programs control panel.

1 Open the Windows Control Panel, and then double-click Add or
Remove Programs.

The Add or Remove Programs window appears.

2 In the list of currently installed programs, click StorNext File System,
and then click Remove.

3 Click Yes to confirm the removal.

4 After the uninstall process is complete, reboot the system.
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Use the following information to perform specific file system
configuration tasks that do not apply to a typical StorNext set up.

Sharing a Library Between Applications

If two or more software applications (on one or multiple machines), are
configured to use the same library, then you must use the following
procedure to enable the library to be shared and to prevent media being
overwritten when these applications are used. This task must be
performed when the Configuration Wizard (CW) is run during initial
StorNext setup and configuration. For more information on using the
CW, refer to the StorNext Installation Guide.

Note: For library sharing to be effective, the steps in the following
procedure must be performed in the order in which they are
presented.

You must have root privileges to perform this task.
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1 When you match hardware devices to their correct slots on the
Matched Devices With Slots screen (you will see this screen during the
execution of Step 4 of the Configuration Wizard, Add Tape Drive),
only configure the tape drives that your software application will
use. You do not need to configure all tape drives listed as part of the
library.

2 Once the tape drives are added and configured in Step 4 of the CW
(Add Tape Drive), but before continuing to Step 5 of the CW (Add
Media), go to a metadata controller and perform these steps:

a Change directory to the config directory. Type:
cd /usr/adic/MSM/internal/config

b List all files in the config directory. Type:
Is -l

¢ Using a text editor, edit the media_file_<library_name> file. For
example:

vi media_file_<library_name>

The media_file contains a filter for barcode labels that are read by
StorNext. This action is performed by using regular expressions.
(A regular expression provides a mechanism to select strings
from a set of character strings. In the above example, the
character strings refer to the barcode labels.) In the example
above, <library_name> is the library that was configured in Step 3,
Add Library, of the CW.

d Set up the pattern matching of the media file.

Multiple entries may exist in the media file. Read the examples in
the file to learn how to set up pattern matching.

These are examples of pattern matching;
scsi_archive 1111.. (brings in all media with the 1111 prefix)

scsi_archive AB9... (brings in all six-character media labels with
the AB9 prefix)

scsi_archive CLNL.. (brings in all media that have the CLN1 prefix)

3 Continue to the Add Media section of the Configuration Wizard.
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Manually Modifying Storage Manager Configuration

fs_sysparm_override
Configuration File

StorNext 3.1.3 Installation Guide

StorNext employs global parameters that define the Storage Manager
configuration. Although the default values in these files are sufficient for
most installations, you can edit the files to customize the StorNext
software for your specific installation. This section provides a procedure
that can be used to modify the following StorNext configuration files:

e Jusr/adic/TSM/config/fs_sysparm_override
e Jusr/adic/TSM/config/filesize.config

* J/usr/adic/TSM/logs/log_params

The fs_sysparm_override configuration file is used to tune items related to
system administration, drives and media, media manager interface, and
other miscellaneous items. For more information about the parameters
that can be placed into the fs_sysparm_override configuration file, refer to
the fs_sysparm.README file.

Caution: Incorrect modification of the fs_sysparm_override
configuration file can cause a serious, adverse effect on
StorNext functionality. Before modifying this file,
Quantum recommends that you contact Quantum Global
Services.

Caution:  If you have files larger than 100GB and are using LTO2
media, the MED_SEG_OVER_LTO parameter may be
modified to a value less than or equal to 190G to reduce
file fragmentation. This has the adverse effect of reducing
the potential for parallel I/O for multiple file segments.
Setting the MED_SEG_OVER_LTO parameter to a value
larger than 190GB may result in allocation failures that
prevent file movement to tape.
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filesize.config The filesize.config configuration file is used to control the file steering
Configuration File feature and has these characteristics:

* Allows the placement of files on different media types, based on the
size of the files

* Specifies which drive pool a policy class should use when storing
data

* Contains specific syntax and usage information

* Enables the system administrator to make changes without recycling
the Tertiary Manager software

log_params The log_params configuration file is used to control various levels of trace
Configuration File logging. The file specifies each log level and how to enable and/or
disable it.

Use the following procedure to modify the fs_sysparm_override,
filesize.config, or log_params configuration files.

1 Use a text editor to open one of the following configuration files:
* Jusr/adic/TSM/config/fs_sysparm_override
* Jusr/adic/TSM/config/filesize.config
* Jusr/adic/TSM/logs/log_params

2 Locate the parameter you want to modify and replace the setting
with a new, valid value.

When editing a file, be sure to follow the format used by entries in the
file. For example, in the fs_sysparm_override and filesize.config files,
all entries must be in the format: name=value;

3 Recycle the Tertiary Manager software.
a Stop the software by typing TSM_control stop
b Restart the software by typing TSM_control start
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Connecting to a StorNext Network Using Xsan 1.4.2

If you are using Apple Xsan 1.4.2, follow the procedure below to connect
to a StorNext network. The procedure consists of mounting the StorNext
file system onto the OSx computer, and then creating an automount.plist
to enable mounting the StorNext file system whenever the Macintosh is
rebooted.

Do not use the procedure if you are using Xsan2, which has a slightly
different procedure described in Connecting to a StorNext Network

Using Xsan 2 on page 119.

Mounting SNFS on the

0Sx Computer Follow this procedure to mount the StorNext file system.

1 Connect the Apple computer to the SAN's metadata Ethernet and
Fibre Channel networks.

2 Install Xsan 1.4.2 software on the Apple computer.

3 After Xsan 1.4.2 is installed, follow these steps to configure the
software:

a On the Apple client, open Xsan Admin, which is located under
the Finder > Applications > Server folder, and then connect to
the Apple computer.

b Select the SAN in the SAN Components list.
¢ Click Setup, and then click Computers.

d Double-click the client in the list (located in the center of the
window).

e Enter the Xsan serial number (printed on a sticker on the Xsan
Installation disc sleeve).

f Click Save, and then quit Xsan Admin.

4 Navigate to an existing StorNext client on the SAN and print a copy
of its fsnameservers file.

On Unix: the fsnamerservers file is located at /usr/cvfs/config/.
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On Windows: the fsnamerservers file is located at
\%cvfsroot%\config\ (where %cvfsroot% is the directory where the
StorNext software is installed). This directory is usually located in
C:\Program Files\Stornext\config\.

5 Create a new plaintext file called fsnameservers in the /Library/
FileSystems/Xsan/config/ directory. Populate the file with the content
of the StorNext file you printed in the previous step.

Note: If the content of the fsnameservers file specifies the
metadata controller by its fully qualified domain name
(FQDN), you must convert this to the metadata controller's
IP address by using the command host <FQDN>

6 Type the command sudo rm /Library/Filesystems/Xsan/config/
.auth_secret to remove the .auth_secret file from the Macintosh OS X
client.

Caution: If you do not remove the .auth_secret file from the
Macintosh OS X client, the metadata controller
server and the client will be unable to
communicate and FSMPM could fail.

7 Restart the Macintosh OS X system by typing on the terminal sudo
reboot. Alternatively, you can restart by selecting Restart in the
Apple menu.

8 Verify that the file system has started by typing in the terminal
[/Library/FileSystems/Xsan/bin/cvadmin. You should see a list of file
systems that contain the StorNext filesystem. If the file system does
not appear in the list, repeat step 3.

9 Create a mount point for the file system by creating a new folder at
/Volumes where the file system will be mounted. The name of this
directory should be the name of the file system. In the terminal type
the following commands:

mkdir -p /Volumes/file_system_name
chmod -R 777 /Volumes/file_system_name

10 Mount the StorNext FS file system to the mount point by typing the
following command in the terminal:
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sudo mount -t acfs fsname /Volumes/fsname (where <fsname> is the
name of the file system). The SNFS filesystem should now be
mounted on the OS X computer.

In order to mount the StorNext file system whenever the Macintosh client
is rebooted, configure the automount.plist file. Xsan 1.4.2 uses the
automount.plist file to mount SAN volumes.

1

Use the command vi /Library/Filesystems/Xsan/config/automount.plist
to create the automount.plist file.

Copy and paste the text from the automount.plist template below into
the file you just created.

Change Volume_name to the name of your mounted file system.

The automount.plist Template

Copy and paste the text from the following template into the
automount.plist file as described in step 2 above.

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE plist PUBLIC “-//Apple Computer//DTD PLIST 1.0//EN”
“http://www.apple.com/DTDs/PropertyList-1.0.dtd”>
<plist version="1.0?7>

<dict>

<key>Volume_name</key>

<dict>

<key>AutoMount</key>
<string>rw</string>
<key>MountOptions</key>

<dict/>

</dict>
<key>Another_volume_name</key>
<dict>

<key>AutoMount</key>
<string>rw</string>
<key>MountOptions</key>

<dict/>

</dict>

</dict>

</plist>
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Connecting to a StorNext Network Using Xsan 2

If you are using Apple Xsan 2.2 or earlier, follow the procedure below to
connect to a StorNext network. The procedure consists of mounting the
StorNext file system onto the Mac OS X computer, and then creating an
automount.plist to enable mounting the StorNext file system whenever
the Macintosh is rebooted.

Do not use the procedure if you are using Xsan 1.4.2, which has a slightly
different procedure described in Connecting to a StorNext Network
Using Xsan 1.4.2 on page 116.

Mounting SNFS on the
Mac OS X Computer

StorNext 3.1.3 Installation Guide

Follow this procedure to mount the StorNext file system.

1 Connect the Apple computer to the SAN's metadata Ethernet and

Fibre Channel networks.

Install Xsan 2 software on the Apple computer. (Xsan 2.1.1 is
supported only by the Leopard operating system. Snow Leopard
operating systems require Xsan 2.2.)

Create the file /etc/systemserialnumbers/xsan using that Macintosh’s
Xsan serial number.

You must create the directory /etc/systemserialnumbers if it doesn't
already exist. The format of the serial number file is a two-line file:
XSAN-020-XXX-XXX-X-XXX-XXX-XXX-XXX-XXX-XXX-X

registered to|organization

Note: The file does not have a trailing return on the last line. Use
the following;:
cat > /etc/systemserialnumbers/xsan and end with "D"D (where
AD7D is control-D control-D)

If you are unable to browse to the systemserialnumbers directory, use
the cat or echo commands to insert information into the Xsan file
under that directory.

Copy from the following template and paste into the file to create the
file config.plist in /Library/Filesystems/Xsan/config/.
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Note: Items in red indicate data you should enter which applies
to your configuration. Do not enter the literal red text
shown in the template.

For example, for <string>My IP Address</string> you would
enter the netmask in the format X.Y.Z.0/24 (for example,
<string>10.65.182.0/24</string>) not the words “My IP
Address.”

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://
www.apple.com/DTDs/PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>computers</key>
<array/>
<key>metadataNetwork</key>
<string>My IP Address</string>
<key>ownerEmail</key>
<string>me@mycompany.com</string>
<key>ownerName</key>
<string>My Name</string>
<key>role</key>
<string>CLIENT</string>
<key>sanName</key>
<string>My SAN name</string>
<key>serialNumbers</key>
<array>
<dict>
<key>license</key>
<string>xsan client license number</string>
<key>organization</key>
<string>organization name</string>
<key>registeredTo</key>
<string>registered to name</string>
</dict>
</array>
</dict>
</plist>

5 Copy from the following template and paste into the file to create an
automount.plist file located in /Library/Filesystems/Xsan/config/.
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Note: Items in red indicate data you should enter which applies
to your configuration. Do not enter the red text shown in
the template.

For example, for <key>file system</key> you would enter
the name of your file system, not “file system.”

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE plist PUBLIC "-//Apple Computer//DTD PLIST 1.0//EN" "http://
www.apple.com/DTDs/PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>file system</key>
<dict>
<key>AutoMount</key>
<string>rw</string>
<key>MountOptions</key>
<dict/>
</dict>
</plist>

6 Navigate to an existing StorNext server on the SAN and copy the
fsnameservers file to your Macintosh client in /Library/Filesystems/Xsan/
config/. This file should contain the IP addresses of the name server
machines.

On Unix: the fsnameservers file is located at /usr/cvfs/config/.

On Windows: the fsnameservers file is located at \%cvfsroot%\config\
(where %cvfsroot% is the directory where the StorNext software is
installed). This directory is usually located in C:\Program
Files\Stornext\config\.

Note: If the content of the fsnameservers file specifies a fully
qualified domain name (FQDN), you must convert this to
the metadata controller's IP address by using the
command host <FQDN>,

7 Run RegisterSeRV in Terminal to ensure that the serial number is
recognized. Text will be returned if the serial number is not
recognized. (No messages are displayed if the serial number is
successfully registered.)
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8 Run the following in Terminal to update Xsan with the new file
system information:

launchctl unload /System/Library/LaunchDaemons/com.apple.xsan.plist
launchctl load /System/Library/LaunchDaemons/com.apple.xsan.plist

Note: Unload will fail if plist is not loaded.

If the file system does not mount automatically, manually mount the
StorNext file system. In the Terminal type xsanctl mount <fsname> Where
<fsname> is the file system name displayed in cvadmin. The SNFS file
system should now be mounted on the Mac OS X computer.

Viewing a Fibre Channel Device

Use this procedure to add a Fibre Channel (FC) device. Before adding a
FC device, first configure the Host Bus Adapter (HBA) card so you can
view the device. Use the fs_scsi -p command to make sure you can view
your devices over FC. FC devices include tape libraries, individual
drives, or RAID disk.

Note: The fs_scsi -p command is only available if the storage
manager is installed on the FSM server.

1 Type the /usr/adic/TSM/util/fs_scsi -p command to make sure that the
necessary devices can be viewed over FC.

* To view tape libraries, access the StorNext GUI to view your tape
libraries.

¢ To view individual drives or RAID LUNs, access either the StorNext
or SNFS GUI

To add a disk, see Chapter 6, “Managing the File System,” in the StorNext
User’s Guide. To add a tape drive to a configured library, see Chapter 8,
“Managing Drives and Disks,” in the StorNext User’s Guide.
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StorNext Log Rolling Administration

Use the following procedures to configure StorNext log rolling options.

Changing Log Rolling Use this procedure to change the frequency of rolling the StorNext logs.
Times This process requires that you edit the tldm crontab to set log times. Use
this procedure to edit tdim crontab.

1 Log on as root.
2 Edit the tdlm crontab and update the sn_log_update script.
Below is an example crontab:

01,7,13,19 * * * Jusr/adic/www/bin/cmdwrap /usr/adic/util/sn_log_update /usr/
adic

where 01,7,13,19 * * * designates the times when logs run.

In this release of StorNext the sn_log_update information is overwritten
and no longer contains the $DEF_SIZE or the $DEF_LOGS variables. These
entries are now contained in the sn_log_update.cfg file

Log Rolling Options

You can change these options to optimize log rolling.

* -s: This option sets the directory where logs are saved (copied) to as
they are rolled. This directory is typically a managed directory. For
example:
sn_log_update [-s <dir>]
where <dir> is the directory where you want the logs to reside.

* $DEF_SIZE = 2000000: This is the default size at which logs are rolled.

Edit this entry in the /usr/adic/util/sn_log_update.cfg file if you want
the log sizes to be larger or smaller.

* $DEF_LOGS = 28: This is the default number of logs that are saved
before they are deleted. Edit this entry in the /usr/adic/util/
sn_log_update.cfg file if you want to save less than 28 logs or are
saving the logs to a managed directory.
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Avoiding Poor System Performance

Most systems run administrator scripts to rebuild namespace databases
and/or to remove certain files. Unfortunately, running these scripts can
degrade StorNext performance. It is recommended that you review
administrator scripts to determine if they may adversely affect your
StorNext installation and its performance.

For example, many UNIX systems have a find command in the root
crontab that traverses the entire directory hierarchy while searching for
old temporary and core files. Typically, the find commands are configured
only to run on the local file system. However by default, these commands
do not skip StorNext file systems because they are considered to be local,
even though the file system manager may be running remotely. StorNext
performance can be dramatically degraded when these commands visit a
StorNext file system if the system contains a large number of files.

If StorNext performance is degraded to an unacceptable level due to the
operation of administrator scripts, you can modify them to skip StorNext
file systems. A sample command (original and modified is shown below:

On IRIX, by default, the root crontab contains the following find
command:

find / -local -type f'(" -name core -0 -name dead.letter *)' -atime +7 -mtime + 7
-exec rm -f'{}" ;'

To prevent the find command from searching in StorNext file systems,
modify it as shown:

‘(' -type d -fstype cvfs -prune ‘)" -0
The modified find command looks like this:

find / -local ‘(' -type d -fstype cvfs )" -0 -type f (* -name core -0 -name
dead.letter )" -atime +7 —mtime +7 -exec rm -f '{}' "}’
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StorNext Files

StorNext creates a series of files that are used and modified to configure a
file system. This section includes an expanded example.cfg file and a
listing of the most commonly used StorNext files with descriptions and
locations for each.

The example.cfg File

The following is listing of the configuration file created by StorNext. This
file is modified during the configuration of a file system. The location for
this file is: /usr/cvfs/examples/example.cfg

#

# A global section for defining file system-wide parameters.

#

# For Explanations of Values in this file see the following:

#

# UNIX Users: man cvfs_config

# Windows Users: Start > Programs > StorNext File System > Help >

# Configuration File Internal Format
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#

GlobalSuperUser Yes ## Must be set to Yes for SNMS Managed File
Systems ##

WindowsSecurity No

Quotas No

FileLocks No

DataMigration No  ## SNMS Managed File Systems Only ##
InodeExpandMin 32K

InodeExpandinc 128K

InodeExpandMax 8M

FsBlockSize 16K

JournalSize 16M

AllocationStrategy ~ Round
MaxConnections 32

ForceStripeAlignment  Yes

Debug 0x0

MaxLogSize aM

MaxLogs 4

#

# Globals Defaulted

#

# ThreadPoolSize 64 # default 16, 2 MB memory per thread

# InodeCacheSize 32K # 800-1000 bytes each, default 8K

# BufferCacheSize 64M # default 32MB

# StripeAlignSize 2M # auto alignment, default MAX(StripeBreadth)
# MaxMBPerClientReserve 50 #in MBs, default 100MB reserved per client
# OpHangLimitSecs 300 # default 180 secs

# DataMigrationThreadPoolSize 128 # Managed only, default 8

# T — x

# A disktype section for defining disk hardware parameters.

*kkkhkkkhkkkhhkkkkkk *kkkhkkkkkkkkkkkk
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[DiskType MetaDrive] ##1+1 Raid 1 Mirrored Pair##
Sectors XXXXXXXX  ## Sectors Per Disk From Command "cvlabel -I" ##
SectorSize 512

[DiskType JournalDrive] ##1+1 Raid 1 Mirrored Pair##
Sectors XXXXXXXX
SectorSize 512

[DiskType VideoDrive] ##8+1 Raid 5 Lun for Video##
Sectors XXXXXXXX
SectorSize 512

[DiskType AudioDrive] ##4+1 Raid 3 Lun for Audio##
Sectors XXXXXXXX
SectorSize 512

[DiskType DataDrive] ##4+1 Raid 5 Lun for Regular Data##
Sectors XXXXXXXX
SectorSize 512

# *kk *kkkk *k%k kkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkk *

# A disk section for defining disks in the hardware configuration.

*kkkhkkkhkkkhhkkkkkk *kkkkkkkkhkkkkkkk

[Disk CvfsDisk0]
Status UP
Type MetaDrive

[Disk CvfsDisk1]
Status UP

Type JournalDrive

[Disk CvfsDisk2]
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Status UP
Type VideoDrive

[Disk CvfsDisk3]
Status UP
Type VideoDrive

[Disk CvfsDisk4]
Status UP
Type VideoDrive

[Disk CvfsDisk5]
Status UP
Type VideoDrive

[Disk CvfsDisk6]
Status UP
Type VideoDrive

[Disk CvfsDisk7]
Status UP
Type VideoDrive

[Disk CvfsDisk8]
Status UP
Type VideoDrive
[Disk CvfsDisk9]
Status UP
Type VideoDrive

[Disk CvfsDisk10]
Status UP
Type AudioDrive

Appendix C StorNext Files
The example.cfg File
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[Disk CvfsDisk11]
Status UP
Type AudioDrive

[Disk CvfsDisk12]
Status UP
Type AudioDrive

[Disk CvfsDisk13]
Status UP
Type AudioDrive

[Disk CvfsDisk14]
Status UP
Type DataDrive

[Disk CvfsDisk15]
Status UP
Type DataDrive

[Disk CvfsDisk16]
Status UP
Type DataDrive

[Disk CvfsDisk17]
Status UP
Type DataDrive

Appendix C StorNext Files
The example.cfg File

# * *

# A stripe section for defining stripe groups.

#

[StripeGroup MetaFiles]

129



Appendix C StorNext Files
The example.cfg File

Status UP

MetaData Yes

Journal No

Exclusive Yes

Read Enabled

Write Enabled
StripeBreadth 256K
MultiPathMethod Rotate
Node CvfsDisk0 0

[StripeGroup JournFiles]
Status UP

Journal Yes

MetaData No

Exclusive Yes

Read Enabled

Write Enabled
StripeBreadth 256K
MultiPathMethod Rotate
Node CvfsDisk1 0

[StripeGroup VideoFiles]
Status UP

Exclusive Yes##Exclusive StripeGroup for Video Files Only##
Affinity VidFiles

Read Enabled

Write Enabled
StripeBreadth 4M
MultiPathMethod Rotate
Node CvfsDisk2 0

Node CvfsDisk3 1

Node CvfsDisk4 2

Node CvfsDisk5 3
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Node CvfsDisk6 4
Node CvfsDisk7 5
Node CvfsDisk8 6
Node CvfsDisk9 7

[StripeGroup AudioFiles]
Status UP

Exclusive Yes##Exclusive StripeGroup for Audio File Only##
Affinity AudFiles

Read Enabled

Write Enabled
StripeBreadth 1M
MultiPathMethod Rotate
Node CvfsDisk10 O

Node CvfsDisk1l 1

Node CvfsDisk12 2

Node CvfsDisk13 3
StripeGroup RegularFiles]
Status UP

Exclusive No##Non-Exclusive StripeGroup for all Files##
Read Enabled

Write Enabled
StripeBreadth 256K
MultiPathMethod Rotate
Node CvfsDisk14 0

Node CvfsDisk15 1

Node CvfsDisk16 2

Node CvfsDisk17 3
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Commonly Used SNFS Files

The following is a list of commonly used SNFS files and provides the
name and location of the files installed during a SNFS installation. Each
entry also includes a brief description of the file’s utility in SNFS
functionality.

¢ [usr/cvfs/bin/
cvadmin — Allows you to view and modify the active SNFS system(s).
cvaffinity — Associates a stripe group with a media type.
cvep — A high-speed file copy utility.
cvdb — A client debugging tool.
cvdbset — A wrapper for cvdb.
cvfsck — A utility to check and repair a SNFS file system.
cvfsd — SNFS server daemon launched at mount time.
cvfsdb — A metadata debugging tool.
cvfsid — Provides the SNFS site identifier
cvlabel — Lists and labels SNFS drives.
cvmkdir — Associates an affinity with a directory.
cvmkfile — Pre-allocates space and attributes for a file.
cvmkfs — Initializes a SNFS file system

cvupdatefs — Modifies the configuration of an existing SNFS file
system.

cvversions — Lists SNFS version information.
fsm — A SNFS server daemon.

fsmpm — A SNFS portmapper daemon.
mount_cvfs — A mount helper for SNFS.
snfsdefrag — Defragments files and file systems.

e Jusr/cvfs/config/

fsmlist — A list of SNFS file systems that have been serviced.
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fsnameservers — Identifies the SNFS name service coordinators.
license.dat — The SNFS license file.

e Jusr/cvfs/data/<FS Name>/log/
Cvlog — debug and runtime messages

e Jusr/cvfs/debug/
cvfsd.out — Displays debug and status messages from cvfsd.
fsmpm.out — Displays debug and status messages from fsmpm.
mountall.out — Displays debug and status messages from mount_cvfs.
nssdbg.out — Displays debug and status messages from fsmpm.

* Jusr/cvfs/CLIENTS/ — The following are client installation files for
various operating systems.

sn_dsm_aix52_client.tar
sn_dsm_irix65f_client.tar
sn_dsm_irix65m_client.tar
sn_dsm_linuxRH_80i386smp_client.tar
sn_dsm_linuxRH_80i386up_client.tar
sn_dsm_linuxRH_AS_3i386smp_client.tar
sn_dsm_linuxRH_AS_3ia64smp_client.tar
sn_dsm_linuxSuUSE_81i386smp_client.tar
sn_dsm_linuxSuSE_81i386up_client.tar
sn_dsm_solaris58sparc64_client.tar
sn_dsm_solaris59sparc64_client.tar
sn_dsm_win2k_client.exe
sn_dsm_winnt_client.exe

e Jusrfcvfs/docs/
external_api.pdf — Documentation for the SNFS API.

* Jusr/cvfs/examples/ — The following are examples of files that are
present in certain file system configurations. For example, the
cvfail.example will be in the configuration file of a system running
failover.

cvfail.example

StorNext 3.1.3 Installation Guide 133

Download from Www.Somanuals.com. All Manuals Search And Download.



StorNext 3.1.3 Installation Guide

Appendix C StorNext Files
Commonly Used SNFS Files

cvlabels.example

cvpaths.example

example.cfg

fsmlist.example
fsnameservers.example
fsports.example

fsroutes.example

lusrilcvfs/lib/

cvextapi.a — A SNFS API library.
libcvfsdmapi.a — A SNFS DMAPI library.
lusr/cvfs/src/

cvapi.c — A sample API application.
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n

This appendix describes how to configure and use the StorNext File
System (SNFS) Quality of Service (QOS) feature. QOS allows real-time
applications to reserve some amount of bandwidth on the storage system.
This is known as real-time I/O (RTIO). SNFS gates (that is, throttles) non-
real-time applications so their I/O accesses do not interfere with the real-
time application.

QOS is a passive implementation in that it does not actively monitor a
process’ activity and then schedule the process so that it receives the
bandwidth it has requested. It is up to real-time applications to gate their
own I/O requests to the desired rate. SNFS QOS provides a “get out of
the way” gating for non-real-time I/O requests so they do not hinder the
real-time requests.

QOS is fully functional in SNFS version 2.1.2 and later. Earlier versions of
SNFS do not support QOS. If a pre-QOS client connects, the file system
manager (FSM) logs a message to syslog. If the pre-QOS client connects
while real-time I/O is in progress, the message is logged at the critical
event level.

The remainder of this document explains the client and server
configuration settings for QOS; describes the use of tokens and callbacks
for gating non-real-time I/ O; describes setting real-time I/ O on a file; and
discusses the performance monitoring tools that are available for
diagnosis.
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Overview

Active vs. Passive

Supported Platforms
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QOS is stripe-group centric; all configuration and operations act on a
specific stripe group. This allows stripe groups with differing access
characteristics to use different real-time settings. When a client requests a
certain amount of real-time I/O, the FSM informs all connected clients of
the amount remaining and available for non-real-time I/ O accesses.

This information is encapsulated in a token. Think of the token as a
capability that enables the client to perform I/O without contacting the
FSM. When the amount of real-time I/O on a stripe group changes, the
FSM informs all connected clients about the change via a callback.

In both the client and the server, QOS is implemented as a state machine.
Each state has a set of events and allowable actions. In this document, the
term state thusly refers to the internal state machine.

QOS is a passive, not active implementation of real-time I/O. In an active
implementation (such as the SGI IRIX guaranteed rate I/O known as
GRIO), the scheduler is tightly coupled with the I/O subsystem. The
qualities of the disk subsystem are well known so the scheduler can
guarantee that a process will be scheduled such that it will receive the
required amount of bandwidth. Since SNFS is a cross-platform file
system that does not have hooks in the operating system scheduler, it
cannot provide such a guarantee.

In a passive implementation, a real-time process gates its I/ O according
to some outside metric (such as a frame rate for specific video formats).
The file system then gates all other non-real-time I/O so they do not
interfere.

These differences cannot be over-stressed. It is a misconception to think
that QOS, despite its name, guarantees a specific amount of real-time I/O
to a process.

QOS has been tested on Windows XP, Linux, IRIX, and Solaris. In the
Windows world, an application gets a handle to a file to perform I/O,
usually via the Win32 CreateFile() API. In the UNIX world, an application
receives a file descriptor (fd) via the open(2) system call. In this document,
“handle” is synonymous with fd.
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Unit of I1/0

Converting MB/sec to I/0/
sec
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The primary configuration for QOS is in the FSM configuration file. No
client configuration is required, although there is a QOS tuning
parameter that can be specified when the file system is mounted.

Real-time I/O is based on well-formed I/O. This means that for the
purposes of determining bandwidth rates, well-formed I/O is
characterized as being a stripe width in size. This makes the best
utilization of the disks in the stripe group and maximizes the transfer
rate. Internally, non-real-time I/O is tracked by number of I/O
operations per second. An I/O operation is a minimum of a file system
block size, and a maximum of the file system block size multiplied by the
stripe breadth

(FsBlocksize * StripeBreadth).
FsBlockSize <= I/0 <= (FsBlocksize * StripeBreadth)

Typically, it is easier to qualify an I/ O subsystem in terms of MB/ sec that
can be sustained. However, internally the file system tracks everything
on an [/O/sec basis. Note that the file system tracks only non-real-time I/
O (that is, it gates only non-real-time I/O). An I/O is a minimum of the
file system block size, and is typically the point at which the file system
hands the request off to the disk driver (loCallDriver in Windows, or a
strategy call in UNIX).

The file system counts the number of I/ Os that have taken place during a
given second. If the number exceeds that which is allotted, the request is
pended until I/ O becomes available (typically in the next second). 1/O is
honored in FIFO fashion; no priority is assigned.

To convert between I/Os and MB/sec, SNFS uses a somewhat unique
formula that quantifies I/ O as well-formed. The rationale behind this is
due to the way in which many video applications make real-time 1/O
requests. To optimize the disk subsystem, real-time I/Os are well-formed
so they saturate the disks. In SNFS terminology, this would be an1/O
that covers all of the disks in a stripe. This can be expressed as follows:
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ios_sec =mb_sec/
(stripe_breadth * stripe_depth *fs_blocksize)

For example, with a file system blocksize of 4k, a stripe_breadth of 384, and
a stripe_depth of four, the equivalent number of I/Os/sec for each well-
formed I/ O would be 216 Mb/sec / (384 * 4 * 4k). This is equivalent to
221184 k/sec / 6144k=361/0O/sec.

Server Configuration

All storage subsystems are different, so users must qualify the I/O
subsystem and determine the maximum amount of I/O bandwidth
available. SNFS relies on the correct setting in the configuration file; if the
storage system changes (for example, because of a new disk array,) the
user must re-qualify the 1/ O subsystem to determine the amount of
bandwidth available. This amount will be specified in the FSM
configuration file. The user can also specify the minimum amount of
bandwidth to be provided to non-real-time applications.

There are five keywords controlling QOS that can be specified in the
stripe group section of the FSM configuration file. Not all keywords need
be present. Typically, the user specifies the RTIO bandwidth in terms of
either number of I/ O operations per second (rtios) or megabytes per
second (rtmb). Keywords are not case sensitive.

For a minimum configuration, only the real-time limit (either rtios or rtmb)
need be specified. All other configuration variables default to reasonable
values.

Table 28 QOS Configuration
Keywords

StorNext 3.1.3 Installation Guide

Name Description Default

Rtios The maximum number of real- 0 (no real-time)
time I/Os allowed in a stripe
group during any one-second
period.

Rtmb Maximum amount of real-time 0 (no real-time)
MB/ sec allowed on the stripe
group during any one-second
period.
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Name Description Default
RtiosReserve Amount of reserve in I/Os/sec Equivalent to

from the maximum allowed for 1MB/sec

non-real-time I/Os. Must be

greater than the equivalent to

1MB/sec or the amount that can

be transferred to a single stripe

line.
RtmbReserve Amount to reserve in MB/sec Must be

from the maximum allowed for greater than 1.

non-real-time I/O. 1MB/ sec
RtTokenTimeout | Time in seconds to wait for clients | 2 seconds

to respond to a token callback.

RTIO Upper Bound

The limit will be specified in terms of I/Os per second (parameter Rtios)
or in terms of MB/sec (parameter Rtmb). Case is not sensitive. Note that
I/Os per second are I/Os of any size to the disk subsystem. Either or both
may be specified. If both are specified, the lower limit is used to throttle

I/O. If neither is specified, no real-time I/O is available on the stripe
group. These parameters are applied to a stripe group definition.

[StripeGroup MyStripeGroup]
Rtios 2048
Rtmb 10

The above example specifies that the storage system can support a
maximum of 2048 I/Os per second at any instant, aggregate among all
the clients, or 10 MB/sec, whichever is lower.

Most real-time I/ O requests will be a stripe line at a time to maximize
performance. Non-real-time I/Os will be a minimum of a file system
block size.
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Note: Itis important to realize that the rtios and rtmb settings refer to
the total amount of sustained bandwidth available on the disk
subsystem. Any I/O, either real-time or non-real-time, will
ultimately be deducted from this overall limit. The
calculations of available real-time and non-real-time are
discussed later.

Specifying rtmb in the FSM configuration file is only
recommended if all I/Os are well formed (that is, a full stripe
width). Otherwise, the conversion between MB/sec and I/Os/
sec using the well-formed I/O calculation could lead to
unexpected results.

Reserve

To prevent deadlock, the QOS implementation never allows zero 1/O/
sec for non-real-time I/O. Otherwise, a system could block with many
critical file system resources held waiting for I/O to become available.
This is especially true via flush-on-close I/ O via the buffer cache. It
becomes extremely difficult to diagnose system hangs because no I/O is
available. For this reason, QOS always reserves some amount of I/O for
non-real-time I/0O.

The minimum amount of non-real-time I/O reserved for non-real-time
applications is one MB/sec. This can be changed via the stripe group
section parameters (again, case is not sensitive). If both are specified, the
lower of the two amounts is chosen. This amount is shared by all non-
real-time applications on each client.

[StripeGroup MyStripeGroup]
RtiosReserve 256

RtmbReserve 2
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Token Timeouts

The RtTokenTimeout parameter controls the amount of time the FSM waits
for clients to respond to callbacks. In most normal SANs, the default two-
second setting is sufficient. This value may need to be changed for a SAN
that has a mixture of client machine types (Linux, NT, IRIX, etc.) that all
have different TCP/IP characteristics. Also, large numbers of clients
(greater than 32) may also require increasing the parameter.

For example, if the FSM should ever fail, the clients will attempt to
reconnect. When the FSM comes back online, the amount of time the
clients take to re-establish their TCP/IP connection to the FSM can differ
wildly. To avoid unnecessary timeouts, the RtTokenTimeout parameter can
be increased, meaning the FSM waits longer for callback responses.

If a client times out on a token retraction, the original requestor receives
an error from the FSM that includes the IP address of the offending client.
This error is logged to syslog, and alternatively to the desktop on
Windows clients. This can help in diagnosing reconnect failures, and in
determining if the token time value should be increased.

Client Configuration

When a client obtains a non-real-time I/O token from the FSM, the token
allows the client a specific amount of non-real-time I/O. If the client is
inactive for a period of time, the token is relinquished and the non-real-
time I/ O released back to the FSM for distribution to other clients. The
timeout period is controlled by the nrtiotokenhold mount option on UNIX
platforms, and the QOS Token Hold Time parameter in the mount options
tab of the SNFS control panel on Windows platforms. The default is sixty
(60) seconds.

This means that after sixty seconds without non-real-time I/O on a stripe
group, the non-real-time token for that stripe group is released. The
parameter should be specified in five (5) second increments. If it is not, it
will be silently rounded up to the next five-second boundary. If the
syslog level is set to debug, the file system dumps out its mount
parameters so the value can be seen.

StorNext 3.1.3 Installation Guide 141

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix D Quality of Service Guide
Real-time 1/O

Real-time I/O

A process requests real-time (ungated) I/O by using the SNFS External
API SetRtio call (F_SETRIO ioctl). A library function is included in the
External API sample source code that provides all the required cross-
platform handling.

As an example, assume that a video playback application requires a
constant rate of 186 MB/sec to correctly display images without dropping
any frames. The application gates itself; that is, it requests I/O at a rate to
satisfy the requirements of correctly displaying an image. QOS provides a
mechanism so other I/O requests do not perturb the real-time display.

In the following example, assume the I/O subsystem has been qualified
at 216 MB/sec. The file system block size is 4k. The disk subsystem is
actually a large RAID array that internally maps many drives to a single
LUN. There are four LUNSs in the stripe group; each LUN is optimized for
a 1.5 MB transfer. This corresponds to the following in the fsm
configuration file:

[StripeGroup MyStripeGroup]
StripeBreadth 384
Node CvfsDisk0 O
Node CvfsDisk1 1
Node CvfsDisk2 2
Node CvfsDisk3 3
Rtmb 216

Also, assume there is only one stripe group for user data in the file
system. As recommended by Quantum, there may be other stripe groups
for metadata and journal that are not shown.
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Initially, all stripe groups in the file system are in non-real-time mode.
Clients make their requests directly to the I/O subsystem without any
gating. In our example, the process requires 186 MB/sec and the system
designers know there will never be a need to support more than one
stream at 186 MB/sec.

The SetRtio request has a number of flags and parameters to control its
operation. These are all documented in the external_api.pdf file that
describes the external API in detail. For this example, set the handle for
the indicated stripe group using the RT_SET parameter.

In most cases, system designers ensure that the amount of rtio is not
oversubscribed. This means that processes will not ask for more rtio than
is specified in the configuration file. However, it is possible to request
more rtio than is configured. The API uses the RT_MUST flag to indicate
that the call must succeed with the specified amount. If the flag is clear,
the call allocates as much as it can. In both cases, the amount allocated is
returned to the caller.

The SetRtio call accepts two different types of handles. The first is a
handle to the root directory. In this mode the stripe group is put into real-
time mode, but no specific file handle is tagged as being ungated. Real-
time I/O continues on the stripe group until it is explicitly cleared with a
SetRtio call on the root directory that specifies the RT_CLEAR flag; the file
system is unmounted; or the system is rebooted. It is up to the application
to make a subsequent call to EnableRtio (F_ENABLERTIO) on a specific
handle.

If the handle in the SetRtio call refers to a regular file, it is the equivalent
of a SetRtio call on the root directory followed by an EnableRtio call. The
file handle will be ungated until it is closed, cleared (RT_CLEAR in a
SetRtio call), or disabled (DisableRtio). When the handle is closed, the
amount of real-time I/O is released back to the system. This causes the
FSM to readjust the amount of bandwidth available to all clients by
issuing a series of callbacks.

The client automatically issues a call to the FSM with the RT_CLEAR flag
specifying the amount of real-time I/O set on the file. If multiple handles
are open on the file —each with a different amount of real-time I/O—only
the last file close triggers the releasing action; all aggregate rtio are
released.
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This automatic clearing of real-time I/O is carried out in the context of
the process that is closing the file. If the FSM cannot be reached for some
reason, the request is enqueued on a daemon and the process closing the
file is allowed to continue. In the background, the daemon attempts to
inform the FSM that the real-time I/O has been released.

Different processes can share the same file in real-time and non-real-time
mode. This is because the level of gating is at the handle level, not the file
level. This allows a real-time process to perform ingest of material (video
data) at the same time as non-real-time processes are performing other
operations on the file.

Figure 59 Sharing Access to
Files

Process A Process B Process C

Non-realtime (gated)

In Figure 59, Process A has ungated access to file foo. Processes B and C
also are accessing file foo, but the client gates their I/O accesses. If
multiple handles are open to the same file and all are in real-time mode,
only the last close of the handle releases the real-time I/O back to the
system. This is because on most platforms the file system is informed
only on the last close of a file.

It is also possible to denote using the RT_NOGATE flag that a handle
should not be gated without specifying any amount of real-time I/O. This
is useful for infrequently accessed files (such as index files) that should
not be counted against the non-real-time I/O. System designers typically
allow for some amount of overage in their I/O subsystem to account for
non-gated files.

Ungated files
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When the FSM receives a request for rtio, it takes the amount reserved
into consideration. The reserve amount functions as a soft limit beyond
which the FSM will not traipse. The calculation for rtio is as follows:

avail_rtio = rtio_limit - rtio_current
avail_rtio -= rtio_reserve

All internal calculations are done in terms of I/O/ sec.

Callbacks

StorNext 3.1.3 Installation Guide

The cornerstones of the communications between the FSM and the client
are callbacks and tokens. A callback is an unsolicited message from the
FSM to the client requesting that the client adjust its real-time I/O
parameters. The callback contains a token that specifies the amount of
non-real-time I/O available on a stripe group.

Initially, all stripe groups in a file system are in non-real-time (ungated)
mode. When the FSM receives the initial request for real-time I/O, it first
issues callbacks to all clients informing them that the stripe group is now
in real-time mode. The token accompanying the message specifies no1/O
is available for non-real-time I/O. Clients must now obtain a non-real-
time token before they can do any non-real-time I/O.

After sending out all callbacks, the FSM sets a timer based on the
RtTokenTimeout value, which by default is set to five seconds. If all clients
respond to the callbacks within the timeout value the rtio request
succeeds, and a response is set to the requesting client.
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Request RTIi
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i 10, RTIO response
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Client C Client D

In the above diagram, a process on client A requests some amount of
RTIO in Step 1. Since this is the first request, the FSM issues callbacks to all
connected clients (Steps 2-5) informing them that the stripe group is now
in real-time mode. The clients respond to the FSM in Steps 6-9. After all
the clients have responded, the FSM responds to the original requesting
client in Step 10.

If the timer expires and one or more clients have not responded, the FSM
must retract the callbacks. It issues a response to the requesting client
with the IP number of the first client that did not respond to the callback.
This allows the requesting client to log the error with the IP number so
system administrators have a chance of diagnosing the failure. It then
sends out callbacks to all the clients to which it first sent the callbacks,
retracting them to the original state. In our example, it would set the
stripe group back to non-real-time mode.

After sending out the callbacks, the FSM waits for a response using the
RtTokenTimeout value as before. If a client again does not respond within
the timeout value, the callbacks are retracted and sent out again. This
repeats until all clients respond. During this time of token retractions,
real-time requests cannot be honored and will only be enqueued.
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Figure 61 Callback Retraction
Example
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The FSM must handle a case where a client does not respond to a callback
within the specified timeout period (RtTokenTimeout). If a client does not
respond to a callback, the FSM must assume the worst: that it is a rogue
that could wreak havoc on real-time I/O. It must retract the tokens it just
issued and return to the previous state.

As mentioned earlier, the original requestor will receive an error
(EREMOTE) and the IP address of the first client that did not respond to
the callback. The FSM enters the token retraction state, and will not honor
any real-time or token requests until it has received positive
acknowledgement from all clients to which it originally sent the
callbacks.

Client A Client B

2-5 FEM callbacks

'1\ \ﬁ\‘ / /; / i/lﬁ 5,6,9 Client callback rosfnses

7. Missing callback response

F$M 10, RTIO failure response

11-14 FSM eallbacks {token

Abor A N R

Client © Client I

In Figure 61, Client A requests some amount of rtio as in Figure 60.
However, assume that Client C did not respond to the initial callback in
time (step 7). The FSM will return a failure to Client A for the initial rtio
request, then send out callbacks to all clients indicating the stripe group is
no longer real-time (steps 11-14). In the example, Client C responds to the
second callback, so the FSM will not send out any more callbacks. The
stripe group is back in non-real-time mode.

Note that this can have interesting repercussions with file systems that
are soft mounted by default (such as Windows). When the caller times
out because other clients are not responding and then gives up and
returns an error to the application, if at some point the FSM is able to
process the rtio request it may result in the stripe group being put into
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real-time mode after the original caller has received an error code. Both
the FSM and clients log their actions extensively to syslog, so if this
situation arises it can be detected.

In Figure 61, if the stripe group were already in real-time mode the FSM
would only send out callbacks to those clients that already have tokens.
Once all clients responded to the token callbacks, the stripe group would
be back in its original state.

A token grants a client some amount of non-real-time I/O for a stripe
group. Tokens are encapsulated in callback messages from the FSM.
Initially, no tokens are required to perform I/O. Once a stripe group is
put into real-time mode, the FSM sends callbacks to all clients informing
them that they will need a token to perform any non-real-time I/O. The
first I/ O after receiving the callback will then request a non-real-time I/ O
token from the FSM.

The FSM calculates the amount of non-real-time bandwidth using the
following formula:

avail_nrtio = rtio_limit - rtio_current;
avail_nrtio /= current_num_nonrtio_clients + 1

In the above calculation, the amount of existing real-time I/ O (rtio_current)
has already been adjusted with the reserve parameter. As each client
requests a non-real-time I/O token, the number of clients increases
(current_num_nonrtio_clients in the above formula) and the amount of
available non-real-time I/O decreases.

Each time there is a change in the amount of non-real-time I/O available,
the FSM sends callbacks to the clients with tokens. It is important to note
that unlike the initial set of callbacks where the FSM sent callbacks to all
connected clients, it is now only necessary to send callbacks to those
clients that have an existing token.

Once a client has a token, it can perform as much I/O per second as is
allowed by that token. It does not need to contact the FSM on every I/O
request. The FSM will inform the client whenever the token changes
value.
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Non-Real-time Non-Real-time

In Figure 62, assume the stripe group is already in real-time mode as a
result of an rtio request from client A. Clients B and D are doing non-real-
time I/ O to the stripe group and have a token that specifies the amount of
non-real-time I/O available. Client C then requests a non-real-time I/O
token in Step 1. The FSM calls back to Clients B and D and specifies the
new token amount in Steps 2-3. The clients respond in Steps 4-5,
acknowledging the new token amount. The FSM then responds to Client
C with the new token in Step 6.

There are two major failures that affect QOS: FSM crashes and client
crashes. These can also be loss of communication (network outages). For
client and server failures, the system attempts to readjust itself to the pre-
failure state without any manual intervention.

149

Download from Www.Somanuals.com. All Manuals Search And Download.



FSM Failures

Client Failures

StorNext 3.1.3 Installation Guide

Appendix D Quality of Service Guide
Callbacks

If the FSM crashes or is stopped, there is no immediate affect on real-time
(ungated) I/O. As long as the I/ O does not need to contact the FSM for
some reason (attribute update, extent request, etc.), the I/ O will continue.
From the standpoint of QOS, the FSM being unavailable has no affect.

Non-real-time I/ O will be pended until the FSM is re-connected. The
rationale for this is that since the stripe group is in real-time mode, there
is no way to know if the parameters have changed while the FSM is
disconnected. The conservative design approach was taken to hold off all
non-real-time I/O until the FSM is reconnected.

Once the client reconnects to the FSM, the client must re-request any real-
time I/O it had previously requested. The FSM does not keep track of
QOS parameters across crashes; that is, the information is not logged and
is not persistent. Therefore, it is up to the clients to inform the FSM of the
amount of required rtio and to put the FSM back into the same state as it
was before the failure.

In most cases, this results in the amount of real-time and non-real-time I/
O being exactly the same as it was before the crash. The only time this
would be different is if the stripe group is oversubscribed. In this case,
since more rtio had been requested than was actually available, and the
FSM had adjusted the request amounts, it is not deterministically possible
to re-create the picture exactly as it was before. Therefore, if a
deterministic picture is required across reboots, it is advisable to not over-
subscribe the amount of real-time I/O.

The process of each client re-requesting rtio is exactly the same as it was
initially; once each client has reestablished its rtio parameters, the non-
real-time I/O is allowed to proceed to request a non-real-time token. It
may take several seconds for the SAN to settle back to its previous state.
It may be necessary to adjust the RtTokenTimeout parameter on the FSM to
account for clients that are slow in reconnecting to the FSM.

When a client disconnects either abruptly (via a crash or a network
partition,) or in a controlled manner (via an unmount), the FSM releases
the client's resources back to the SAN. If the client had real-time I/O on
the stripe group, that amount of real-time I/O is released back to the
system. This causes a series of callbacks to the clients (all clients if the
stripe group is transitioning from real-time to non-real-time,) informing
them of the new amount of non-real-time I/O available.

If the client had a non-real-time I/O token, the token is released and the
amount of non-real-time I/O available is recalculated. Callbacks are sent
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to all clients that have tokens informing them of the new amount of non-
real-time [/O available.

While it is not a failure case, the handling of a client token release is
exactly the same as in the case where the client disconnected. All clients
retain non-real-time tokens for a fixed amount of time. The default is 60
seconds. This can be controlled via the nrtiotokentimeout mount option.
After the specified period of inactivity (i.e., no non-real-time I/O on the
stripe group), the client will release the token back to the FSM. The FSM
will re-calculate the amount of non-real-time bandwidth available, and
send out callbacks to other clients.

Therefore, if a situation exists where a periodic I/O operation occurs
every 70 seconds, it would be beneficial to set the nrtiotokentime mount
option to something greater than or equal to 70 seconds to cut down on
system and SAN overhead.

Monitoring

StorNext 3.1.3 Installation Guide

The current real-time statistics are available via the cvadmin utility. The
show long command has been enhanced to provide information as to the
current limit, the minimum amount reserved for non-real-time I/0O, the
number of active clients, the amount currently committed, and the
amount a non-real-time application could hope to get when requesting
I/0.

Whenever the stripe group status changes (such as from non-real-time to
real-time mode), an event is logged to syslog (system event log on
Windows platforms).

On the NT platform, real-time performance is also available via the
perfmon utility. There are counters for both the client (SNFS Client) and
FSM (SNFS File System Server [FSS]). In the client, a number of rtio_xxx
counters are available to track the number of real-time I/Os/sec, number
of non-real-time I/O requests, non-real-time I/O starvation, and other
counters. A full explanation of each counter is provided with the perfmon
utility by clicking Explain. In the FSM, information about the number of
outstanding non-real-time clients, available rtio, and other QOS
information is available.
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Performance counters are not enabled by default in the client. To enable
them, you must execute cvdb -P ; this toggles the state of collection. To
turn off the perfmon counters, do another cvdb -P. To re-enable, again do
cvdb -P, and so on. To clear all client counters to zero, disable, then re-
enable the counters with cvdb -P.

Sharing Disk Resources

As a final example, consider the case of a full-featured disk subsystem
(Redundant Array of Very Expensive Disks, or RAVED) using a very
high speed interconnect. Many clients can share these disk arrays, but it is
sometimes desirable to limit a client's access to the array. QOS provides a
mechanism for political bandwidth management so that no one client can
consume all the bandwidth of the channel interconnects.

In such a scenario, the stripe group would always be in real-time mode.
Each client would have a token specifying the number of 1/Os/sec
permissible. In the current version of QOS, it is unfortunately not possible
to assign different non-real-time limits to different clients.

The foundation of such an approach is a simple program that puts the
stripe group into real-time mode as soon as the FSM is up and servicing
requests. An example of such a program is included in the source code for
the External APL

Once the stripe group is in real-time mode, the bandwidth as specified in
the FSM configuration file is shared by all clients. In cases such as this, the
real-time limit (rtios or rtmb) is calculated to be the total bandwidth
desired to each client times the number of possible clients.

As each client attempted to access the disk subsystem, it would obtain a
token. The FSM would send out callbacks adjusting down the amount of
bandwidth available. No one client would be allowed to exceed the
threshold specified in the non-real-time token. This assures fairness
among all the clients.
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